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1. Введение 
 
1.1. Авторские права  

 
Информация, приведенная в данном документе, может быть изменена 
без предварительного уведомления и не может рассматриваться как 
обязательство со стороны ООО Энергопромис. ООО Энергопромис не 
несет ответственности за любые ошибки, которые могут встретиться в 
этом документе. 
 
Ни при каких условиях ООО Энергопромис не несет ответственности за 
любой прямой или косвенный ущерб, который может быть причинен 
использованием данного документа или программного обеспечения, в 
нем описанного.    
 
Данный документ либо его составные части не могут быть 
воспроизведены или скопированы без письменного разрешения ООО 
Энергопромис. 
 
1.2. Торговые марки 
 
АВВ является зарегистрированной торговой маркой АВВ Group. 
Все остальные торговые марки являются собственностью их законных 
владельцев. 
 
1.3. Общая информация 
 
Данное руководство дает общее представление о создание экранов 
процесса в SYS 600 *9.1 при помощи инструмента Display Builder. Далее 
будут описаны основные функции и возможности данной программы и 
связанные с ними процедуры редактирования. 
 
Display Builder – это графический редактор, который используется для 
создания активных мнемосхем, выполняющих контроль и управление 
первичным процессом. При помощи редактора возможно создание 
объектов произвольного типа и их сохранение в палитре объектов. В 
дальнейшем экземпляры таких объектов могут подключаться к 
различным источникам данных и использоваться как составные части 
экранов процесса. 
 
Данное руководство разделено на следующие основные разделы: 
 
Обзор редактора Display Builder 
 
Этот раздел представляет собой введение в основные функции 
редактора и дает обзор основных операций и наиболее часто 
используемых инструментов. 
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Свойства символов библиотеки SA 
 
В этом разделе приведена информация об используемых в редакторе 
символах и их атрибутах. 
 
Функциональность библиотеки SA 
 
Этот раздел предоставляет общую информацию о функциональности 
символов библиотеки SA. 
 
Свойства динамических данных 
 
В данном разделе приведено детальное описание различных свойств и 
действий, таких как источники данных, переменные, объектная 
динамика и правила. 
 
1.4. Условные символы 
 
Некоторая информация, приведенная в данном руководстве, 
обозначена специальными символами для того, чтобы подчеркнуть ее 
важность или обратить внимание на вопросы, связанные с 
безопасностью. Назначение соответствующих символов приведено 
ниже: 
 

Информационный символ обращает внимание на 
сопутствующие факты и условия. 

 
 

Символ подсказки обращает внимание, как можно 
использовать данную функцию в конкретных проектах. 

   
 
1.5. Условные обозначения 
 
Обратите внимание на следующие обозначения, принятые в данном 
руководстве: 
 
• Названия экранных элементов (например, заголовки окон,  название  

полей диалоговых окон и т.д.) напечатаны прописными буквами и 
выделены курсивом. 

• Заглавные буквы использованы для обозначения клавиш, если они 
отмечены на клавиатуре (например,  нажмите клавишу CTRL). 
Исключением является клавиша ввода, которой присвоено 
обозначение Enter (например, нажмите Enter). 

• Буквы нижнего регистра используются для названия клавиш, не 
обозначенных на клавиатуре, например пробел, кавычки и т.д. 

• Нажмите CTRL+C означает, что во время нажатия клавиши C, 
клавишу CTRL следует удерживать нажатой (данное сочетание 
клавиш выполняет операцию копирования). 
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• Нажмите ESC E C означает, что эти клавиши должны быть нажаты 

последовательно. 
• Названия кнопок и переключателей выделены жирным шрифтом. 

Например, нажмите ОК. 
• Названия меню и подменю выделены жирным шрифтом. Например, 

меню File. 
• Следующее обозначение принято для отображения очередности 

операции с меню: Название меню > Подменю > Каскадное 
подменю. Например, Файл > Открыть > Новый проект. 

• Меню Пуск в нижнем левом углу экрана во всех случаях является 
меню Пуск в панели задач Windows. 

• Системные подсказки и сообщения, а также данные, вводимые 
пользователем, печатаются шрифтом Courier. Например, при вводе 
пользователем некоторой величины, находящейся вне диапазона, 
будет отображаться следующее сообщение: 

       Введенное значение недействительно.  
       Значение должно быть в диапазоне от 0 до 30. 

Пользователю может быть выдан запрос на ввод определенного 
текста, например MIF349. В этом случае строка в процедуре будет 
показывать следующее: 
 MIF349 

 
Переменные обозначены прописными буквами: 
sequence name 
 
1.6. Терминология 
 
Следующий список приводит пояснение некоторых терминов, 
связанных с редактором Display Builder, которые важны для понимания 
его функций. Приведенные термины являются уникальными и 
используются только в системе управления MicroSCADA Pro SYS 600.   
  
 
Термин Описание 
Клат-файл (clut file) Color LookUp Table – файл в котором Display 

Builder сохраняет информацию о значениях RGB 
для каждого цвета в цветовой палитре. 

произвольные 
атрибуты 

Специфические для данного экрана ключи, 
хранящие текстовые значения. 

источник данных Источник входных данных, определяющих 
поведение элементов экрана процесса.  
В SYS 600 первичным источником данных 
является база данных процесса MicroSCADA. 
Кроме того, в качестве источника данных может 
выступать какой-либо файл, область памяти 
экрана или константные значения.   
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Термин Описание 
переменная данных Единичная структура в источнике данных. 

Каждая переменная обладает значением, 
именем, типом, областью видимости и формой 
представления. Различные источники данных 
могут содержать различные типы переменных, 
например, в файле могут содержаться 
переменные действительного или текстового 
типа. Область видимости закрытой переменной 
ограничивается только экраном, в котором 
данная переменная определена. Открытые 
переменные объявляются для экранов, 
используемых в качестве подэкранов. 
Переменная может быть представлена в 
скалярной, векторной или матричной форме.      

экран Экран содержит все объекты, свойства, 
источники данных и отображения переменных, 
которые были созданы или отредактированы 
посредством Display Builder. Экраны 
сохраняются в файлах формата .v или .sd.     

область рисования Область, где можно размещать объекты экрана. 
объект Графический элемент экрана процесса либо 

логический элемент базы данных процесса 
MicroSCADA. Графические объекты 
подразделяются на примитивные объекты 
(линии, прямоугольники и т.п.), текстовые 
объекты, графы, символы, точечные рисунки, 
объекты ввода данных и элементы управления 
MFC. 

SA-символы Набор стандартных символов для создания 
приложений, используемых в системах 
автоматизации подстанций и управления 
передачей и распределением электрической 
энергии 

символ (subdrawing) Символы – это экраны, созданные в Display 
Builder, и сохраненные в файле формата .sd. 

 
1.7. Аббревиатуры 
 
Аббревиатура Описание 
DMS Автоматизированная система диспетчерского 

управления  
ASCII Американский стандартный код обмена 

информацией     
MFC Microsoft Foundation Classes – набор базовых 

компонентов интерфейса пользователя Windows
SA Автоматизация подстанций 
VBA Visual Basic for Application 
WMF Метафайл Windows 
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2. Обзор редактора Display Builder 
 
Display Builder – это редактор для создания графических интерфейсов. 
Он позволяет создавать графические представления объектов в 
интерфейсе, описывать отображаемые ими данные и задавать их 
динамическое поведение. 
 
Процесс рисования интерфейса не требует программирования. Экраны 
легко создаются непосредственно в области рисования, диалоговые 
окна позволяют контролировать все аспекты процесса редактирования, 
включая задание характеристик и обработку данных. Display Builder 
выполняет присваивание всем динамическим элементам значений по 
умолчанию, что значительно сокращает время, необходимое на 
разработку полнографических экранов процесса. 
 
2.1. О данном разделе 
      
Этот раздел представляет собой введение в основные функции 
редактора и дает обзор основных операций и наиболее часто 
используемых инструментов. 
 
2.2. Системные требования 
 
Для более удобной работы рекомендуется использовать видеоадаптер с 
возможностью одновременного  подключения двух мониторов.   
Остальные системные требования соответствуют общим требованиям, 
предъявляемым к системе программным обеспечением MicroSCADA. 
 
2.3. Запуск и закрытие программы 
 
Установка Display Builder выполняется в ходе общей установки 
программного пакета MicroSCADA SYS 600 *9.1. Для запуска редактора 
следует выбрать пункт главного меню Инструменты > Системные 
инструменты > Display Builder основного окна Monitor Pro. После 
запуска редактора область редактирования пуста. Если в редакторе 
открыт новый либо существующий экран (см. раздел 2.7.), в заголовке 
окна отображается путь и имя файла экрана, а также название 
приложения и группа доступа SYS 600 (см. Рис. 2.3.-1).    
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Рис. 2.3.-1 SYS 600 Display Builder 
 
2.4. Меню 
 
На панели главного меню расположены пункты File, Edit, Window и 
Help, общие для большинства приложений Windows и дополнительные 
пункты View, Object, Tools и Actions. 
 

   
Рис. 2.4.-1 Панель главного меню Display Builder   
 
Пункт меню File предоставляет стандартные команды для работы с 
файлами. Существует возможность одновременного открытия 
нескольких файлов и настройки вариантов их отображения при помощи 
меню Window. 
 

Reload: Перезагружает экран. Используется, если нужно отобразить 
изменения открытого экрана при изменении соответствующего файла.  
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Merge: Выполняет слияние предварительно сохраненного экрана с 
текущим. 
Import: Выполняет импорт метафайлов Windows (.wmf) в редактор 
 
Пункт меню Edit содержит стандартные команды редактирования, 
такие как отмена, повтор и выбор объекта. Кроме того, здесь 
представлены некоторые специфические опции. Можно вырезать, 
копировать и вставлять объекты в пределах экрана или между 
экранами. 
 

Paste Offset: Задает смещение для копий вставляемых объектов 
 
Clear Undo: Очищает буфер повтора и отмены операций 
 
Auto Repeat: Включает режим автоматического повтора при 
создании копий, что позволяет вставлять объекты одного типа без их 
повторного выбора. 
 
Data Variables: Открывает диалог Data Selection, в котором 
производится редактирование переменных источника данных 
текущего экрана процесса. 
 
Preferences: Открывает диалог Preferences, в котором задаются 
основные свойства Display Builder, такие как настройки сетки, 
таблицы цветов, режима перетаскивания объектов и пути поиска 
файлов. 
 

Пункт меню View позволяет настраивать вид экрана в области 
рисования. 
 

Pan To: Выполняет перерисовку экрана с центром в указанной точке. 
 
Refresh: Выполняет обновление экрана для устранения искажений, 
возникающий в процессе рисования. 
 
Object Counts: Показывает текущее количество объектов экрана. 
 

Пункт меню Object используется для конфигурации и манипулирования 
графическими объектами экрана. 
 

Properties: Открывает диалог Object Properties для объекта, 
выбранного в области рисования. Данный диалог позволяет задавать 
стандартные свойства объекта. Вид диалога зависит от типа 
выбранного объекта. 
 
Dynamics: Показывает вкладку Dynamics диалога Object Properties, 
где задаются динамические свойства для выбранного объекта. 
 
Rules: Показывает вкладку Rules диалога Object Properties для 
выбранного объекта. 
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Пункт меню Tools содержит опции, используемые для настройки меню 
и панелей инструментов Display Builder. 
 
Пункт меню Windows позволяет настраивать расположение окон, 
открытых в Display Builder. 
 
Пункт меню Actions предоставляет доступ к специфическим функциям 
библиотеки SA (см. Раздел 4). 
 
Пункт меню Help предоставляет доступ к справочной системе и 
информации об авторских правах. 
 
Контекстное меню появляется при нажатии правой клавиши мыши в 
интерфейсе окна Display Builder. Оно предоставляет быстрый доступ к 
доступным в данный момент командам. 
 
2.5. Панели инструментов 
 
Для упрощения процесса редактирования в Display Builder используется 
большое количество различных панелей инструментов. Панели 
инструментов позволяют легко добавлять графические объекты, 
изменять их атрибуты, форматировать текст и выполнять ряд других 
задач. 
 
Для того чтобы отобразить панели инструментов, не показываемые  
по умолчанию, необходимо выполнить следующую процедуру: 
 

1. Выбрать пункт меню Tools > Customize. Будет показан диалог 
Customize (см. Раздел 2.8.) 

2. На закладке Toolbars выбрать панель инструментов, которую 
нужно отобразить. 

 

3. Нажать Close. 
 

Панели инструментов: 
 

Панель Standard: Содержит опции, аналогичные стандартной  
панели меню. 
 

 
 

 Рис. 2.5.-1 Панель инструментов Standard   
 
Панель Format: Позволяет задавать свойства текста, такие как 
размер и стиль.  
 

 
 

Рис. 2.5.-2 Панель инструментов Format  
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Панель Alignment: Содержит команды для выравнивания и 
распределения групп объектов. 

 

 
 
Рис. 2.5.-3 Панель инструментов Alignment  
 
Панель Attributes: Содержит команды управления 
характеристиками объектов, такими как ширина и стиль линий, 
контуры и заливка, цвета и позволяет выбирать объекты по их 
названиям. 
 

 
         

Рис. 2.5.-4 Панель инструментов Attributes  
 
Панель Controls: Содержит команды для создания элементов 
управления MFC, доступных в Display Builder. 
 

 
 
Рис. 2.5.-5 Панель инструментов Controls  
 
Панель Objects: Содержит команды для создания графических 
объектов всех доступных типов. 
 

 
 
Рис. 2.5.-6 Панель инструментов Objects  

 
Панель Run Mode: Позволяет управлять экраном в режиме 
тестового исполнения. 
 

 
 
Рис. 2.5.-7 Панель инструментов Run Mode  
 
Панель Transform: Содержит команды для манипулирования 
графическими объектами – сжатия и увеличения, вращения, 
отображения, перемещения на задний или передний план, 
перемещения по узлам сетки. 
 

 
 
Рис. 2.5.-8 Панель инструментов Transform  
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Панель Zoom: Содержит команды для масштабирования 
области рисования.  
 

 
 
Рис. 2.5.-9 Панель инструментов Zoom  
 

 

tt

2.6. Диалоги 
 
В процессе создания динамической графики в Display Builder 
используются следующие диалоговые окна: 
 

• Диалог Data Selection предназначен для выбора источника 
данных и переменных данных экрана. Диалог отображается 
каждый раз, когда возникает необходимость выбрать или 
изменить переменную данных, связанную с некоторым 
компонентом в Display Builder, таким как динамический объект, 
динамическое свойство или правило. 

• Диалог Preferences предназначен для задания различных 
настроек, которые определяют параметры области рисования. 
Эти параметры оказывают влияние на весь редактор в целом. 
Настройки сохраняются при выходе из программы и 
загружаются при ее повторном запуске. 

• Диалог Object Count отображает распределение кучи памяти 
экрана и количество его объектов. 

• Диалог View Properties позволяет добавлять комментарий, 
задавать цвет фона, устанавливать начальное разрешение 
экрана, добавлять и редактировать специфические свойства, 
настройки сетки и определять правила на уровне экрана. 

• Диалог Object Properties предназначен для определения 
свойств выбранного в Display Builder объекта.    

• Диалог Graph Properties используется для настройки графов 
Display Builder. 

• Диалог Input Object Properties используется для конфигурации 
объектов ввода данных Display Builder. 

• Диалог MFC Control Properties предназначен для определения 
свойств выбранного элемента управления MFC. 

• Диалог Customize позволяет определить какие панели 
инструментов и команды должны отображаться интерфейсом 
Display Builder. Пользователь может добавлять или убирать 
панели с экрана, а также создавать свои собственные панели и 
настраивать размещение командных кнопок.  

• Диалог Pale e используется для создания произвольных 
символов 

• Диалог Error Messages отображается в случае возникновения 
ошибки и содержит детализированную информацию о 
действиях, которые сгенерировали ошибку. 
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• Диалог Topology Informa ion  отображает выходную 

информацию функции динамической окраски шин 
t

• Диалог Busbar Coloring Setting  используется для настройки 
параметров функции динамической окраски шин 

• Диалог Color Setting Tool применяется для настройки 
логических цветов экрана и символов SA. 

 
Используйте индексированный список в конце документа, чтобы найти 
описание ситуаций, когда используются описанные выше диалоговые 
окна. 
 
2.7. Типы файлов 
 
Файлы, используемые Display Builder для различных целей, различаются 
при помощи расширений имени файла. Диалоговое окно открытия 
файла использует фильтр для отбора соответствующего типа файла в 
зависимости от контекста текущей операции. По-умолчанию для 
файлов экрана используется расширение .v. Символы сохраняются в 
файлах с расширением .sd. Файл экрана, используемого в качестве 
шаблона для объекта ввода, имеет расширение .lay. Выпадающее меню 
с типами расширений позволяет пользователю фильтровать 
отбираемые файлы. Кроме того, файлы экрана могут быть сохранены 
вообще без расширения.     
 
2.7.1. Создание нового файла 
 
После запуска редактора Display Builder новый файл может быть открыт 
при помощи меню File > New. Эта команда используется также в том 
случае, если нужно создать новый файл в процессе работы с уже 
открытым или еще не сохраненным файлом.  
 

 
 
Рис. 2.7 1.-1 Создание нового файла .  
 
2.7.2. Открытие существующего файла   
             
Существующий файл экрана может быть открыт при помощи меню File 
> Open. Будет отображено диалоговое окно Open. Следует выбрать 
нужный файл и нажать кнопку Open.  
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Рис. 2.7 2.-1 Открытие существующего файла.    
 
Не рекомендуется одновременно открывать большое количество 
экранных файлов. Это может существенно замедлить процесс их 
обработки. 
 
Импортирование файлов в экран 
 
Существует возможность импортировать файлы типа wmf в Display 
Builder. Процедура импортирования открывает выбранный файл внутри 
Display Builder и преобразует его содержание в редактируемые объекты. 
 
2.7.3. Сохранение файла 
 
Весь редактируемый экран или его определенная часть может быть 
сохранена в файл. Этот файл может в дальнейшем использоваться в 
качестве файла экрана или символа. 
 
Чтобы сохранить весь экран целиком следует: 
 

1. Выбрать пункт меню File 
2. Выбрать пункт меню Save или Save As. Будет отображено 

диалоговое окно Save As, фильтр типа файла будет установлен в 
значение .v. 

 
Чтобы сохранить часть экрана в файл следует: 
 

1. Выбрать объекты, которые должны быть сохранены в файле. 
2. Выбрать пункт меню File > Save Selection. Будет отображено 

диалоговое окно Save As, фильтр типа файла будет установлен в 
значение .sd. 

 
Использование диалога Save As 
 
Диалоговое окно Save As отображается с фильтром типа файла, 
установленным в определенное значение в зависимости от выбранной 
опции сохранения. Например, если была выбрана команда Save 
Selection, при помощи фильтра будут отобраны файлы с расширением 
.sd. 
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.
 

 

 
Рис. 2.7 3.-1 Диалог Save As 

Чтобы сохранить экран следует: 
 

1. Ввести имя файла в соответствующем поле  
2. Выбрать тип сохраняемого файла из выпадающего списка Тип

файла 
3. Если требуемое имя файла отображено в поле Имя файла, 

нажать кнопку Сохранить. 
 

Если выполняется сохранение части экрана, будут сохранены только те 
источники данных, которые используются выбранными для сохранения 
объектами. 
 
2.8. Работа с экранами 
 
В следующих разделах будет приведено описание общих функций для 
работы с экранами. 
 
Настройка вида 
 
Пользователь имеет возможность определять, какие панели 
инструментов и командные кнопки будут отображаться интерфейсом   
Display Builder. Панели могут быть отображены или скрыты. 
Пользователь может создавать новые панели инструментов и 
настраивать расположение кнопок на них. 
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ДиалогCustomize используется также для отображения или скрытия 
панели Objec  Browser (см. Раздел 4.5.). Диалоговое окно Customize 
открывается при помощи пункта меню Tools > Customize.  

t

 

 
 
Рис. 2.8.-1 Диалог Customize 
 
Редактирование настроек 
 
Интерфейс Display Builder содержит ряд настроек, которые определяют 
параметры области рисования. Эти параметры оказывают влияние на 
весь редактор в целом. Настройки сохраняются при выходе из 
программы и загружаются при ее повторном запуске. 
 
Диалоговое окно Preferences открывается при выборе пункта меню Edit 
> Preferences.  
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Рис. 2.8.-2 Диалог Pre erences f
 
2.8.1. Режим редактирования и режим 
выполнения 
 
Чтобы перевести Display Builder в режим тестового выполнения экрана, 
следует использовать кнопки, расположенные на панели инструментов 
Run Mode, см. Рис. 2.5.-7. 
 
 Данные кнопки позволяют управлять экраном в тестовом режиме: 
 

Go: Запускает выполнение экрана. Выполнение будет 
продолжаться до тех пор, пока пользователь не явно не 
остановит. Кнопки Slow, Fast, Pause или Single Step также 
запускают выполнение экрана. 
 
Slow: Уменьшает скорость выполнения. 
 
Stop: Прекращает выполнение экрана и переводит редактор в 
режим редактирования. 
 
Fast: Повышает скорость выполнения. 
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Pause: Прерывает выполнение экрана. Повторное нажатие 
продолжает выполнение. 
 
Single Step: Выполняет пошаговое выполнение через 
одиночную итерацию при каждом нажатии. 
 
Update Interval: Задает текущий интервал обновления экрана 
в миллисекундах. Значение увеличивается или уменьшается 
соответственно при нажатии кнопок Fast или Slow. 
 
Control Panel: Кнопки данной панели позволяют 
масштабировать и центрировать экран в режиме выполнения. 
 
Stretch: Переключает экран в режим растягивания, чтобы 
заполнить всю доступную в окне область. 
 

На рисунке 2.8.1.-1 показан интерфейс экрана после нажатия кнопки 
Go. Количество выполненных интеракций отображается с правой 
стороны строки состояния.    

 

 
 

.  Рис. 2.8 1.-1 Режим выполнения 
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В режиме растягивания объекты отображаются с размером отличным от 
того, который используется при редактировании. Кнопка Stretch не 
показывается по умолчанию.  
Чтобы отобразить кнопку Stretch следует: 
 

1. Выбрать пункт меню Tools > Customize. 
2. На закладке Commands выбрать меню Run. 
3. Добавить кнопку Stretch на панель Run Mode. 
4. Нажать Close. 

 
Режим выполнения не реализует всех функциональных 
возможностей SYS 600 Monitor Pro. Например, окна 
управления и контекстные меню объектов не отображаются. 
В процессе создания экрана рекомендуется тестировать его 
также при помощи Monitor Pro. 

 
Объекты ввода данных в режиме выполнения 
 
Объекты ввода данных активны всегда, когда они видимы. Когда экран 
находится в режиме выполнения, объекта ввода принимают вводимые 
пользователем значения и отображают их, даже если была нажата 
кнопка Pause. Графы и динамические объекты, использующие те же 
переменные данных, не отображают текущие значения, если итерации 
приостановлены.  
 
2.8.2. Настройки вида 
 
Display Builder позволяет задавать настройки вида экрана. Для этого 
следует выбрать пункт меню View > Properties.  
 

   
 
Рис. 2.8 2.-1 Диалог View Properties .
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Диалоговое окно View Properties содержит следующие закладки: 
 

• General: Позволяет ввести комментарий, который будет сохранен 
вместе с экраном.  

 

 

 
 

 

• Color: Используется для выбора фонового цвета экрана и цвета 
области вне экрана, если экран меньше области рисования

• Initial Resolution: Предназначена для ввода информации, 
определяющей начальный размер экрана при его открытии в 
Display Builder или приложении. 

• Rules: Позволяет определить изменения, происходящие в экране 
в ответ на определенные условия или действия пользователя.

• Custom: Предназначена для создания специфических атрибутов 
экрана

• Grid: Задание настроек сетки

Задавать цвет фона, общий для всех экранов, рекомендуется 
при помощи инструмента Color Setting Tool. 

 
2.8.3. Масштабирование 
 
Display Builder позволяет масштабировать различные области экрана с 
различным коэффициентом. Каждый раз, когда экран выходит за 
границы области рисования, отображаются полосы прокрутки для для 
перемещения экрана. Опции масштабирования расположены на панели 
инструментов Zoom (см. Раздел 2.5.). 
 
Пользователь может задавать коэффициент, определяющий степень 
увеличения либо уменьшения экрана при однократном изменении 
масштаба. Использование данной функции не влияет на текущее 
представление экрана в области рисования. 
 
Чтобы задать коэффициент масштабирования следует: 
 

1. Выбрать пункт меню View > Zoom By. Будет открыто 
диалоговое окно Zoom By Factor 

2. Использовать передвигающийся ползунок или ввести значение 
вручную в текстовое поле.   

 

 
 
Рис. 2.8 3.-1 Задание коэффициента масштабирования.   
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Для того чтобы перерисовать экран с центром в точке, отмеченной 
курсором, нужно нажать кнопку Pan To на панели инструментов 
масштабирования. Следует заметить, что точка центрирования может 
располагаться только ниже или правее вне области рисования. 
 
2.8.4. Использование сетки 
 
Сетка используется для облегчения процесса выравнивания объектов. 
Она отображается как массив точек в области рисования. Если сетка 
включена, она может использоваться для позиционирования объектов 
вручную или при помощи опции Snap To Grid (см. далее). 
 
Чтобы включить или отключить сетку нужно воспользоваться пунктом 
меню View > Grid >Display Grid.  
 
Включенный режим отображения сетки показывается при помощи 
значка. Пользователь может изменять расстояние между узлами сетки. 
Каждая команда увеличения расстояния увеличивает его вдвое, а 
команда уменьшения уменьшает расстояние в два раза. Расстояние 
между узлами сетки остается постоянным относительно объектов на 
экране, когда пользователь масштабирует или центрирует 
изображение. 
 
Чтобы изменить расстояние между узлами сетки следует: 
 

1. Выбрать пункт меню View > Grid. 
2. Выбрать пункт Increase Spacing (увеличить расстояние) или 

Decrease Spacing (уменьшить расстояние). 
 

Использование опции Snap to Grid 
 
Включенная опция Snap To Grid позволяет размещать контрольные 
точки только в узлах сетки, независимо от того включена сетка или 
нет. 
 
Чтобы включить или отключить режим Snap To Grid нужно выбрать 
пункт меню View > Grid > Snap. Установленный значок 
свидетельствует о включенном режиме привязки. 
 
Если объект был создан, когда режим привязки не был включен, и 
необходимо поместить объект в некоторый узел сетки, следует 
выделить данный объект, выбран его контрольную точку и перетащить 
ее к нужному узлу. Контрольная точка будет привязана к ближайшему 
узлу сетки. 
 
2.8.5. Координаты курсора 
 
Display Builder поддерживает два различных варианта представления 
координат. Если выбрать пункт меню View > Coordinates > World, 
точка отсчета (0,0) будет расположена в центре экрана. Тогда, нижний 
левый край экрана будет иметь координаты (-16 383, -16 383), а 
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верхний правый (16 383, 16 383). При выборе пункта меню View > 
Coordinates > Screen, точка отсчета располагается в левом нижнем 
углу области рисования. Текущие координаты курсора могут 
отображаться в строке состояния. Чтобы отключить данную опцию 
следует выбрать пункт меню View > Coordinates > None. 
 
Выбранная система отсчета координат влияет на отображение 
контрольных точек объекта в диалоге Object Properties. Если 
отображение координат отключено, контрольные точки показываются в 
последней выбранной системе отсчета. 
 
 

t

Практически всегда рекомендуется использовать систему 
отсчета координат world , поскольку она не зависит от 
текущего уровня масштабирования, точки центрирования или 
разрешения экрана. 

 
2.9. Создание объектов 
 
Display Builder содержит ряд инструментов для создания простых 
объектов. Объекты этого типа расположены на панели инструментов 
Object. Процедура создания проста и однотипна для всех объектов. 
Характеристики объектов могут быть изменены при помощи панели 
инструментов Attribu e. Следующий раздел содержит краткое описание 
процедуры создания объектов. 
 
Количество объектов 
 
Пользователь имеет возможность получить информацию об общем 
количестве объектов, находящихся на экране и в куче памяти. Для 
этого нужно выбрать пункт меню View > Object Counts. 
 

 
 
Рис. 2.9.-1 Диалог Object Count 
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Свойства объектов 
 
Пользователь имеет возможность настраивать многие свойства 
объекта, выбранного в Display Builder. Чтобы отобразить диалоговое 
окно Object Properties нужно выбрать пункт меню Object > Properties 
после того, как был произведен выбор соответствующего объекта.   
 

 
 
Рис. 2.9.-2 Определение свойств объекта   
 
Режим автоповтора 
 
Режим автоповтора позволяет последовательно создавать 
множественные экземпляры объектов одного типа без необходимости 
каждый раз выбирать тип создаваемого объекта. В данном режиме 
невозможно создание символов и точечных рисунков. 
 
Чтобы активировать режим автоповтора следует: 
 

1. Выбрать пункт меню Edit > Auto Repeat. 
2. Выбрать тип создаваемого объекта. 

 
Чтобы выйти из режима автоповтора и вернуть курсор в режим 
регулярного выбора объектов, нужно выбрать значок курсора на 
панели объектов либо повторно воспользоваться меню Edit > Auto 
Repeat. 
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2.9.1. Линии 
 
Объект линия представляет собой прямой отрезок между двумя 
точками. 
 
Чтобы создать линию следует: 
 

1. Нажать кнопку линии на панели инструментов Object 
2. Щелкнуть в области рисования начальную точку и протянуть 

линию до конечной точки.  
 

2.9.2. Фигуры 
 
Процедура создания различных фигур, таких как прямоугольники, 
многоугольники, окружности, эллипсы, дуги и т.п., аналогична 
процедуре создания линий. 
 
Например, чтобы создать прямоугольник следует: 
 

1. Нажать кнопку прямоугольника на панели объектов 
2. Щелкнуть в области рисования начальную точку и растянуть 

прямоугольник до противоположной точки.  
 
Следует отметить, что стороны прямоугольника всегда параллельны 
границам области рисования. 
 
2.9.3. Текстовые объекты 
 
Текстовые объекты типа true type представляют собой строки символов, 
которые обрабатываются как единое целое. Такие объекты могут 
масштабироваться. Пользователь имеет возможность задавать размер 
символов, стиль шрифта, форму и наклон. Текстовые объекты типа true 
type предоставляют возможность выбора из широкого диапазона 
доступных шрифтов. 
 
Чтобы создавать текстовый объект true type следует: 
 

1. Нажать кнопку True Type text на панели объектов. 
2. Выбрать якорную точку в области рисования. 
3. Ввести нужный текст (может быть многострочным). 
4. После окончания ввода текста, нажать кнопку ESC или щелкнуть 

левой клавишей мыши. 
 

Если включен режим reshape, контрольные точки текстового объекта 
видимы. Положение контрольной точки указывает на якорную точку 
текстового объекта в зависимости от настроек Anchor Position. 
     
Текстовые объекты векторного типа прорисовываются как 
последовательности линий. Данные объекты представляют собой 
строки символов, которые обрабатываются как единое целое.  
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Пользователь имеет возможность задавать размер символов, стиль 
шрифта, форму и наклон. Текстовые объекты векторного типа 
предоставляют возможность выбора из широкого диапазона доступных 
шрифтов. По умолчанию, кнопка создания векторных текстовых 
объектов не отображается при запуске Display Builder.  
 
Чтобы отобразить кнопку создания текстовых объектов векторного типа 
следует: 
 
1. Выбрать пункт меню Tools > Customize. Будет показано 

диалоговое окно Customize. 
2. На закладке Command выбрать Objec  Creation t
3. Добавить кнопку Vector text на панель инструментов Objects. 
4. Нажать Close. 

 
Настройка панелей инструментов описана в Разделе 2.4. 
 
Чтобы создать текстовый объект векторного типа следует:    
 

1. Нажать кнопку Vector text на панели объектов. 
2. Выбрать якорную точку в области рисования. 
3. Ввести нужный текст (может быть многострочным). 
4. После окончания ввода текста, нажать кнопку ESC или щелкнуть 

левой клавишей мыши. 
 
Текстовые объекты типа hardware представляют собой строки 
символов, которые обрабатываются как единое целое. Такие объекты 
зависят от аппаратного обеспечения и следовательно не могут 
масштабироваться вместе с остальной частью экрана. Текстовые 
объекты типа hardware не предоставляют возможность выбора из 
широкого диапазона доступных шрифтов. По умолчанию, кнопка 
создания текстовых объектов типа hardware не отображается при 
запуске Display Builder. Процедура отображения кнопки аналогична 
таковой для кнопки векторных объектов. 
 
Чтобы создать текстовый объект типа hardware следует:    
 

1. Нажать кнопку hardware text на панели объектов. 
2. Выбрать якорную точку в области рисования. 
3. Ввести нужный текст (может быть многострочным). 
4. После окончания ввода текста, нажать кнопку ESC. 
 
Текстовые объекты могут использоваться для отображения статических 
или динамических значений. Это означает, что пользователь может 
настроить динамическое изменение текстовых строк, отображаемых 
текстовыми объектами. Более подробная информация приведена в 
Разделе 5.4.      
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2.9.4. Графы 
 
Объект граф (graph) представляет собой график или диаграмму, 
которая отображает некоторые данные.  
 
Чтобы создать объект типа граф следует: 
 

1. Нажать кнопку Graph на панели инструментов объектов. 
2. Удерживая нажатой правую кнопку мыши, нарисовать в области 

рисования прямоугольник, определяющий размер объекта. По 
умолчанию будет создан граф типа столбиковая диаграмма (Bar 
Chart). 

 
Чтобы изменить формат созданного графа следует:   
 

1. Выполнить двойной щелчок мышью по выбранному объекту, чтобы 
отобразить диалоговое окно Graph Properties, см. Рис. 2.9.4.-1. 

2. Перейти на закладкуTypes. 
3. Выбрать значок с нужным типом. 

 

  
 
Рис. 2.9 4.-1 Диалог Graph Properties .
 

Отображаемые графом данные могут проступать через другие 
объекты, расположенные над ним. Таким образом, графы не 
должны перекрываться другими объектами. 
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Чтобы отобразить диалоговое окно со свойствами графа, можно нажать 
на нем правой клавишей мыши и выбрать во всплывающем меню пункт 
Graph Properties. 
Диалоговое окно Graph Properties состоит из следующих закладок: 
 
• Basic: Позволяет настраивать большинство основных компонентов 

графа 
• Variables: Позволяет добавлять, заменять и редактировать 

переменные данных, подключенные к выбранному графу. Кроме 
того, позволяет изменять характеристики этих переменных. 

• Types: На данной закладке производиться выбор типа графа 
• X Axis: Настройка компонентов горизонтальной оси графа 
• Y Axis: Настройка компонентов вертикальной оси графа 
 

2.9.5. Символы (subdrawings) 
 
Символ (subdrawing) – это некоторый экран, показываемый как часть 
текущего экрана. Объект типа символ обрабатывается как единое 
целое, это означает, что невозможно редактировать отдельные 
компоненты символа в текущем экране. Для этого следует отрыть файл 
символа как отдельный экран в новом окне. Файл символа должен быть 
создан до того, как символ может использоваться в качестве объекта в 
других экранах. 
 
Чтобы создать объект символа следует: 
 

1. Нажать кнопку Subdrawings на панели инструментов Object. 
Будет отображено диалоговое окно Open File, фильтр типа файла 
будет установлен в значение Subdrawing Files. 

2. Выбрать файл, нажать кнопку Open.  
3. Указать якорную точку в области рисования. 

 
Символ отображается с центром в якорной точке. Для того чтобы его 
графические компоненты центрировались относительно этой точки, 
исходный файл символа должен быть создан таким образом, чтобы все 
его графические компоненты были отцентрированы относительно 
центра экрана. 
 
2.9.6. Точечные рисунки 
 
Объект bitmap применяется для отображения растровых рисунков из 
файлов, которые были созданы и сохранены в совместимом точечном 
формате. Эти объекты имеют две контрольные точки и изменяют свой 
размер в процессе масштабирования экрана. Например, если точечный 
рисунок используется в качестве фона экрана, размер рисунка всегда 
одинаково пропорционален размеру экрана в независимости от 
текущего масштаба. Совместимыми являются следующие форматы: 
формат GIF от Compuserve Corporation, формат PPM Jef Poskanzer и 
Microsoft Windows BMP. Точечные рисунки должны быть 1,4 или 8-
битными DIB. Для использования точечных рисунков собственного 
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формата их необходимо преобразовать в один из совместимых 
форматов. 
 
Объект bitmap может быть создан из файла при помощи кнопки Bitmap 
на панели инструментов Object. Если нужно создать объект bitmap, 
содержащий изображение редактируемого экрана, следует нажать 
стрелку возле кнопки Bitmap и выбрать опцию From Screen. При 
использовании опции From File до создания объекта следует убедиться 
в существовании соответствующего файла. 
 
Чтобы создать объект bitmap из файла следует: 
 

1. Выбрать опцию From File. Будет отображено диалоговое окно 
Open File с фильтром типа файла установленным для отбора 
файлов Windows Bitmap. 

2. Выбрать нужный файл. 
3. Нажать кнопку Открыть. 

 
Если режим Scale with Zoom выключен, объект bitmap имеет только 
одну якорную точку. Текущая настройка привязки якоря не оказывает 
влияния на расположение объекта в процессе его создания, она может 
быть изменена после. Если режим Scale with Zoom включен, задание 
свойств якорной точки для объекта bitmap недоступно. 
 
2.9.7. Объекты ввода 
 
Объекты вода данных (input objects) используется для ввода значений 
либо выбора меню пользователем. Эти объекты позволяют создавать 
интерактивный интерфейс, при помощи которого пользователь может 
управлять информацией в приложении. Объекты ввода данных состоят 
из двух основных элементов: 
 
• интерактивного типа 
• и интерактивного шаблона 

 
Интерактивный тип определяет форму взаимодействия с объектом 
(например, использование ползунка или меню). Интерактивный шаблон 
управляет физическим представлением объекта, таким как количество 
позиций управления или размер интерактивной области. 
Интерактивный шаблон представляет собой экран, созданный в Display 
Builder. Кнопка создания объектов ввода данных не отображается по 
умолчанию при запуске Display Builder. 
 
Чтобы отобразить кнопку создания объектов ввода следует: 
 

1. Выбрать пункт меню Tools > Customize. Будет показано 
диалоговое окно Customize. 

2. На закладке Command выбрать Objec  Creation t
3. Добавить кнопку Input object на панель инструментов Objects. 
4. Нажать Close. 
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Чтобы создать объект ввода (input object) следует: 
 

1. Нажать кнопку Input object на панели инструментов Object. 
2. Удерживая нажатой правую кнопку мыши, нарисовать в области 

рисования прямоугольник, определяющий размер объекта. 
 

Чтобы задать интерактивный тип объекта или выбрать файл шаблона 
следует дважды щелкнуть мышью на нужном объекте. Будет открыто 
диалоговое окно nput Object Properties. Набор показанных в окне меню 
будет зависеть от типа выбранного объекта.   

I

 

    
 
Рис. 2.9 7.-1 Диалог Input Object P operties. . r
 
2.9.8. Элементы управления MFC 
 
Панель инструментов Controls содержит ряд кнопок, каждая из которых 
представляет некоторый элемент интерфейса пользователя Microsoft 
Windows, который может быть создан в Display Builder. 
 
Чтобы создать элемент управления MFC следует: 
 

1. Нажать соответствующую кнопку на панели инструментов Controls. 
2. Удерживая нажатой правую кнопку мыши, нарисовать в области 

рисования прямоугольник, определяющий размер и расположение 
объекта. 

 
Чтобы сконфигурировать элемент управления MFC следует: 
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1. Дважды щелкнуть мышью на элементе MFC и открыть диалоговое 

окно MFC Control Properties. Для некоторых типов элементов щелчок 
должен быть выполнен строго на границе элемента. 

2. В открытом окне задать значения стандартных свойств элемента 
управления MFC. 

 

 
 
Рис. 2.9.-3 Задание свойств элемента управления MFC   
 
Набор показанных в окне закладок будет зависеть от типа выбранного 
элемента управления, так же как и набор задаваемых свойств. Все 
элементы управления имеют свойство ID. Показываемое начальное 
значение этого свойства определяется редактором Display Builder. 
Пользователь может изменить это значение, однако оно должно 
оставаться уникальным в пределах всего приложения. 
 
2.10. Манипулирование объектами 
 
Пользователь может манипулировать объектами самым различным 
образом. Доступные команды собраны в меню Object. 
 
Далее приведены функции, применимые к объектам: 
 
• перемещение 
• копирование 
• вырезание 
• вставка 
• редактирование 
• вращение 
• задание порядка 
• масштабирование 
• отражение 
• выравнивание 
• распределение 
• задание цвета 

 
Некоторые из этих функций описаны более подробно далее. 
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2.11. Использование палитры символов 
 
Чтобы отобразить палитру символов нужно выбрать пункт меню 
Window > Show Palette. 
 

 
 
Рис. 2.11.-1 Открытие палитры символов   
 
Диалоговое окно Palette содержит символы библиотеки SA и различные 
символы общего назначения, которые могут быть использованы для 
создания экранов процесса. 
 

 
 
Рис. 2.11.-2 Диалог Palette 
 
2.11.1. Добавление символов в палитру 
 
Палитра позволяет добавлять в экран сложную графику как некий 
одиночный объект. Пользователь может сохранить символ и объект 
типа bitmap в палитре и затем использовать их для создания объектов 
экрана. Сохранение символов может выполняться путем создания 
объектов в Display Builder и последующим их добавлением в палитру 
либо путем копирования файла символа в соответствующий каталог 
файловой структуры палитры. Более подробная информация о каталоге 
палитры приведена в Разделе 2.11.5. 
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2.11.1.1. Добавление в палитру символа экрана 
 
Описания в этом разделе процедура берет текущие выделенные 
объекты и создает файл, который сохраняет копию этих объектов в 
структуре каталогов палитры. Пользователь имеет возможность 
выбрать любые типы объектов, включая также другие символы.   
 
Если для добавления символа был выбран только один уже 
существующий символ, то добавляемый символ будет сохранен в новом 
файле. Создаваемый файл не является дубликатом файла, в котором 
содержится исходный символ. Это означает, что если для исходного 
символа были заданы динамические свойства или правила и 
используется процедура добавления символа экрана в палитру, то 
добавленный символ будет также содержать все присвоенные 
динамические свойства и правила.  
 
Чтобы добавить символ экрана в палитру следует: 
 

1. Перейти на соответствующую закладку в окне Palette. Новый 
символ добавляется на текущую страницу. Процесс создания 
новых страниц описан в разделе 2.11.3. По умолчанию новый 
символ получает имя GroupN.sd, где N – последовательно 
увеличиваемый порядковый номер. После переименования 
символа его номер будет использован снова. 

2. Выбрать графические объекты, формирующие новый символ. 
Символ может содержать любые объекты из текущего экрана, 
включая динамические объекты, другие символы и объекты 
bitmap. 

3. Нажать правую клавишу мыши и выбрать из контекстного меню 
пункт Add to Palette. Точечный рисунок для нового символа с 
новым именем по умолчанию будет добавлен в палитру. 

 
При использовании данного метода для добавления символа в палитру, 
создается файл в подкаталоге выбранной страницы палитры. Вместе с 
файлом символа создается также файл соответствующего точечного 
рисунка. Изменение имени символа палитры затрагивает оба этих 
файла.     
 
2.11.1.2. Добавление в палитру файла символа  
 
Описания в этом разделе процедура берет текущие выделенные 
объекты и создает файл, который сохраняет копию этих объектов в 
структуре каталогов палитры. Полученный файл является точной 
копией исходного файла, содержащего выбранный символ. Это 
означает, что если для исходного символа были заданы динамические 
свойства или правила и используется процедура добавления файла 
символа в палитру, то добавленный символ не будет содержать 
динамические свойства и правила, заданные для исходного символа.  
 
Новому файлу будет присвоено имя, которое имел файл экрана, 
использовавшийся для создания символа. При повторном 
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использовании данной процедуры создания символа к имени файла 
будет добавлен некоторый последовательный номер. 
 
Использование описанного в этом разделе метода для создания файла 
символа в палитре не затрагивает ссылок на символы. Если в экране 
процесса используется ссылка на объект символа и необходимо 
использовать новый файл из структуры каталогов палитры, 
пользователь должен отредактировать путь к объекту символа. 
 
Описанная процедура  использует опцию Add Subdrawing to Palette. 
Эта опция не показывается по умолчанию при запуске Display Builder.  
 
Чтобы отобразить опцию Add Subdrawing to Palette следует: 
 

1. Выбрать пункт меню Tools > Customize. Будет показано 
диалоговое окно Customize. 

2. На закладке Command выбрать File. 
3. Добавить опцию Add Subdrawing to Palette в меню File. 
4. Нажать Close. 

 
Чтобы добавить в палитру символ в качестве дубликата исходного 
файла следует: 
 

1. Перейти на соответствующую закладку в окне Palette. Новый 
символ добавляется на текущую страницу. Процесс создания 
новых страниц описан в разделе 2.11.3. По умолчанию новый 
символ получает имя файла экрана, использованного для создания 
символа. При повторном использовании данной процедуры к 
имени файла будет добавлен некоторый последовательный номер. 

2. Выбрать объект символа для файла символа. 
3. Выбрать пункт меню File > Add Subdrawing to Palette.  

Точечный рисунок для нового символа с новым именем по 
умолчанию будет добавлен в палитру. 

 
При использовании данного метода для добавления символа в палитру, 
создается файл в подкаталоге выбранной страницы палитры. Вместе с 
файлом символа создается также файл соответствующего точечного 
рисунка. Изменение имени символа палитры затрагивает оба этих 
файла.     
 
2.11.1.3. Добавление в палитру символа или 
точечного рисунка из файла 
 
Пользователь может добавить символ или объект bitmap в палитру 
путем копирования файла символа или точечного рисунка в структуру 
каталогов палитры. Копируемый файл должен существовать до начала 
данной процедуры. Создание новых файлов подробно описано в 
Разделе 2.7.1. Добавление символов в палитру при помощи выбранных 
объектов экрана описано в Разделе 2.11.1.1.      
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Чтобы добавить символ или точечный рисунок из файла в палитру 
следует: 
 

1. Перейти на соответствующую закладку в окне Palette. Новый 
символ добавляется на текущую страницу. Процесс создания 
новых страниц описан в разделе 2.11.3.  

2. Щелкнуть правой кнопкой мыши по палитре для открытия 
контекстного меню. 

3. Выбрать пункт меню Add Item. Будет показано диалоговое окно 
Add Object to Palette.   

4. Задать тип объекта. 
 

 
 
Рис. 2.11.1.3. 1 Диалог Add Object to Palette -  
 

5. Задать имя файла. Для выбора файла при помощи проводника 
файлов можно использовать кнопку … напротив поля Object. 

6. В поле Palette Item Label ввести надпись, которая будет 
отображаться для символа в палитре. Данное действие не 
является обязательным, в случае если надпись не задана, по 
умолчанию для символа будет использоваться имя файла. 
Название символа может быть изменено непосредственно в 
палитре в любое время. 

7. Выбрать точечный рисунок, представляющий отображение 
символа в палитре. Данный шаг является опциональным. 
Выбранный здесь файл будет использоваться символом палитры. 
Этот файл копируется в соответствующий каталог с атрибутом 
«скрытый». Точечный рисунок отображается немедленно после 
выбора. 

 
Альтернативный вариант состоит в следующем: 
 

1. Войти в каталог, содержащий нужный файл. 
2. Выбрать файл, который следует добавить в палитру. Можно 

выбрать несколько файлов сразу. 
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3. Перетащить или скопировать файлы в нужный каталог палитры. 

Файлы должны иметь соответствующее расширение.  
Когда файлы перетаскиваются в палитру, новый символ отображаются 
немедленно. При выполнении операции вставки и копирования, новые 
символы не отображаются вплоть до перезапуска Display Builder. 
 
2.11.2. Создание объектов из палитры 
 
Палитра предоставляет возможность легкого создания символов и 
точечных рисунков в редактируемом экране. Тип файла, 
ассоциированного с символом, определяет, создается он как объект 
символа или как точечный рисунок.  
 
Чтобы создать объект из палитры следует: 
 

1. Перейти на соответствующую закладку в окне Palette. 
2. Выбрать символ в палитре и удерживать кнопку мыши нажатой. 

Когда пользователь щелкает по какому-либо символу, содержание  
файла показывается в окне предварительного просмотра. Если 
символ содержит динамическую графику, она также отображается. 

3. Перетащить символ в экран. 
4. Отпустить кнопку мыши. 

 
Если выбранный объект – точечный рисунок, он будет создан с 
размером по умолчанию. Описанная в этом разделе процедура создает 
как объекты символов, так и объекты bitmap в зависимости от того, 
какой файл  ассоциирован с выбранным символом палитры. 
 
2.11.3. Добавление страниц в палитру 
 
Пользователь имеет возможность добавлять произвольные страницы в 
палитру. 
 
Чтобы добавить страницу в палитру следует: 
 

1. Щелкнуть правой кнопкой мыши по палитре для открытия 
контекстного меню. 

2. Выбрать пункт меню Add Tab. Новая страница будет добавлена 
немедленно. Странице будет присвоено имя по умолчанию – New
Tab. 

 

3. Перейти на созданную закладку New Tab. 
4. Снова щелкнуть правой кнопкой мыши по палитре для открытия 

контекстного меню и выбрать пункт Rename Tab. 
5. Ввести новое имя страницы и нажать OK.  
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Рис. 2.11.3.-1 Добавление новой страницы в палитру   
 
Другой вариант добавления страницы заключается в создании нового 
подкаталога в каталоге палитры. При создании такого каталога он 
будет показан как новая закладка палитры с именем, соответствующим 
имени созданного подкаталога. 
 
Например, чтобы добавить страницу для gif-файлов следует: 
 

1. Перейти в каталог палитры Display Builder. 
2. Создать новый подкаталог с именем Gifs. 

 
После выполнения данной процедуры, новая страница будет 
отображена в палитре при запуске Display Builder. 
 
2.11.4. Скрытые файлы и страницы палитры 
 
Если в окне палитры отображаются ненужные файлы или закладки 
страниц, пользователь может скрыть их. Это позволяет убрать 
страницы или объекты из палитры без необходимости их удаления в 
структуре каталогов. 
 
Скрытие файлов или страниц 
 
Скрытие символа или закладки страницы не удаляет соответствующий 
файл или каталог. Для их удаления нужно воспользоваться 
проводником Windows.      
 
Чтобы скрыть страницу палитры при помощи проводника Windows, 
следует установить атрибут «Скрытый» для соответствующего каталога 
файловой системы. 
 
Чтобы скрыть страницу непосредственно из палитры следует: 
 

1. Перейти на соответствующую закладку в окне Palette.  
2. Щелкнуть правой кнопкой мыши по палитре для открытия 

контекстного меню. 
3. Выбрать пункт Tab List. Будет показано диалоговое окно Tab List. 
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4. Снять отметки со страниц, которые нужно скрыть. 

 

    
 
Рис. 2.11.4.-1 Скрытие страниц палитры   
 
Установка отметки напротив названия страницы вернет отображение 
соответствующей закладки палитры. 
 
Чтобы скрыть символ непосредственно из палитры следует: 
 

1. Перейти на соответствующую закладку в окне Palette.  
2. Выбрать символ для скрытия 
3. Щелкнуть правой кнопкой мыши по палитре для открытия 

контекстного меню. 
4. Выбрать пункт Hide Item.  

 
Чтобы скрыть символ палитры при помощи проводника Windows, 
следует установить атрибут «Скрытый» для соответствующего файла 
символа. 
 
Чтобы восстановить отображение символа либо страницы при помощи  
проводника Windows, следует снять атрибут «скрытый» для 
соответствующего файла или каталога. Символ или закладка страницы 
будут показаны при следующем запуске Display Builder. 
 
Отображение страниц 
  
Пользователь имеет возможность восстановить отображение скрытых 
ранее страниц палитры.  
 
Чтобы отобразить скрытую страницу следует: 
 

1. Перейти на соответствующую закладку в окне Palette.  
2. Щелкнуть правой кнопкой мыши по палитре для открытия 

контекстного меню. 
3. Выбрать пункт Tab List. Будет показано диалоговое окно Tab List. 
4. Установить отметки для страниц, которые нужно отобразить. 

 
Снятие отметки напротив названия страницы сделает соответствующую  
закладку страницы скрытой. 
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2.11.5. Каталог палитры 
 
Файлы, отображаемые в палитре, размещаются в подкаталогах в 
основном каталоге палитры символов Display Builder. Основной каталог 
палитры находится в \sc\prog\graphicsEngine\Palette. Файлы палитры 
должны иметь соответствующее расширение для того, чтобы с их 
помощью создавать объекты Display Builder. Например, bitmap-файлы 
должны иметь расширение .bmp или .gif, а файлы символов - .sd. Для 
создания объектов, Display Builder может обрабатывать только 
несжатые 1, 4 или 8-битовые DIB-файлы, но для экранов могут 
использоваться bitmap-файлы любого типа. 
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3. Свойства символов библиотеки SA  
 
3.1. О данном разделе 
 
В данном разделе приведена информация об использовании в Display 
Builder символов их атрибутов. 
 
3.2. Специфические атрибуты символов SA 
 
Экран SA-символа может содержать следующие специфические 
атрибуты, перечисленные в таблице далее. 
 

Название Описание и значение 

ABB SA symbols 
Все SA-символы имеет данный атрибут. 
Используется для хранения информации о 
версии. 

SADefaultColor  

В этом атрибуте хранится Clut-индекс, 
используемый для инициализации значений 
цвета создаваемых объектов. 
 
Возможные значения: 0…255. 

SAObjectType 

Все SA-символы имеет данный атрибут. 
Значение определяет индивидуальный тип 
символа, например Breaker или 3-Winding 
Transformer. 

SARepresentation  

Данный атрибут используется, если два или 
более символов имеют эквивалентную 
функциональность, но разное 
представление. Значение хранит название 
представления, например, Breaker 
представляется двумя различными 
символами в стандарте IEC и ANSI.   

SASuperType 

Данный атрибут имеют символы, 
принадлежащие к некоторой логической 
группе более высокого уровня. 
 
Возможные значения: Switching Device, 
Transformer, Busbar, Measurement. 
Примитивная линия рассматривается 
принадлежащей к группе Busbar, если она 
участвует в формировании топологии.   
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SATopology 

Данный атрибут указывает на то, что 
символ имеет точки присоединения 
(hotspots) и может являться частью 
топологии динамической окраски шин. 
Только такие символы могут 
обрабатываться функцией окраски шин. 
Символ с данным атрибутом может 
автоматически привязываться к точкам 
присоединения других символов. 
 
Значение не используется. 

SAAllowStretch 

Данный атрибут указывает на то, что при 
выполнении функции Snap to Symbol символ 
может не только перемещаться, но и 
растягиваться для присоединения ко 
второму ближайшему символу в экране. 
 
Значение не используется. 

SAAllowSnapToMiddle 

Данный атрибут указывает на то, что другие 
символы могут присоединяться не только к 
крайним точкам (hotspot) этого символа, но 
также и к виртуальной прямой их 
соединяющей. 
 
Значение не используется.  

SASnapToMiddle 

Символы с таким атрибутом могут 
присоединяться к виртуальной прямой, 
соединяющей две крайние точки (hotspot) 
другого символа. 
 
Значение не используется. 

ToolLauncherProgId 

Значение атрибута используется для 
сохранения ProgId инструмента, который 
запускается при нажатии на символ левой 
клавишей мыши в SYS 600 Monitor Pro. 

SANoRotate 

Символ с таким атрибутом не может быть 
повернут. 
 
Значение не используется. 

SAOrientation 

Данный атрибут используется для двух 
идентичных символов, различающихся 
только горизонтальной или вертикальной 
ориентацией. 
 
Возможные значения: Horizontal, Vertical. 
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3.3. Общие SA-символы 
 
3.3.1. Горизонтальный сегмент шин 
 
Таблица 3.3.1-1 Horizontal Busbar 
 

Имя файла 

Basbar Horizontal.sd  

Специфический атрибут Значение 

SAObjectType Horizontal Busbar 

SASuperType Busbar 

SATopology 
 

SAAllowStretch 
 

SAAllowSnapToMiddle 
  

SASnapToMiddle 
 

SANoRotate 
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3.3.2. Угловой сегмент шин 
 
Таблица 3.3.2.-1 L-Busbar 
 

Имя файла 

Basbar L.sd  

Специфический атрибут Значение 

SAObjectType L-Busbar 

SASuperType Busbar 

SATopology 
 

SANoRotate 
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3.3.3. Вертикальный сегмент шин 
 
Таблица 3.3.3-1 Vertical Busbar 
 

Имя файла 

Basbar Vertical.sd  

Специфический атрибут Значение 

SAObjectType Vertical Busbar 

SASuperType Busbar 

SATopology 
 

SAAllowStretch 
 

SAAllowSnapToMiddle 
  

SASnapToMiddle 
 

SANoRotate 
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3.3.4. Конденсатор  
 
Таблица 3.3.4.-1 Capacitor 
 

Имя файла 

 
Capacitor H.sd 
Capacitor.sd  

Специфический атрибут Значение 

SAObjectType Capacitor 

SATopology 
 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

 
 
3.3.5. Заземление  
 
Таблица 3.3.5.-1 Earth Symbol 
 

Имя файла 

 
Earth H.sd 
Earth.sd  

Специфический атрибут Значение 

SAObjectType Earth 

SATopology 
 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

SADefaultColor 58 
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3.3.6. Генератор 
 
Таблица 3.3.6.-1 Generator 
 

Имя файла 

 
Generator.sd 

Переменная данных Значение 

External Color Float: Код цвета, задаваемый внешним 
компонентом, например DMS 600 

Voltage Level (kV) Float: Уровень напряжения в киловольтах

Специфический атрибут Значение 

SAObjectType Generator 

SATopology 
 

SANoRotate 
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3.3.7. IED 
 
Таблица 3.3.7.-1 IED 
 

Имя файла 

 
IED.sd 

Переменная данных Значение 

Alarm Signal Float: 0=Нет, 1=Неквитирован (мигает), 
2=Квитирован  

Caption Text: Надпись, показываемая символом 

Специфический атрибут Значение 

SAObjectType IED 

ToolLauncherProgId  LIB510RT.LIB510IEDTools 

SANoRotate 
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3.3.8. PCM IED 
 
Таблица 3.3.8.-1 PCM IED 
 

Имя файла 

 
IED_pcm.sd 

Переменная данных Значение 

Alarm Signal Float: 0=Нет, 1=Неквитирован (мигает), 
2=Квитирован  

Caption Text: Надпись, показываемая символом 

Специфический атрибут Значение 

SAObjectType IED 

ToolLauncherProgId  IedPcm.Ied 

SANoRotate 
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3.3.9. Индикатор линии 
 
Таблица 3.3.9.-1 Line Indicator 
 

Имя файла 

 
Line Indicator H.sd 
Line Indicator.sd 

Переменная данных Значение 

Position 

Float: Меньше нуля=Отходящий фидер, 
0=Нет питания, Больше нуля=Ввод. 
Модуль значения равен коду цвета, 
задаваемого внешним компонентом, 
например DMS 600 

Voltage Level (kV) Float: Уровень напряжения в киловольтах

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Line Indicator 

SATopology 
 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.3.10. Двигатель 
 
Таблица 3.3.10.-1 Motor 
 

Имя файла 

 
Motor.sd 

Специфический атрибут Значение 

SAObjectType Motor 

SATopology 
 

SANoRotate 
 

 
 
3.3.11. Реактор 
 
Таблица 3.3.11.-1 Reactor 
 

Имя файла 

 
Reactor H.sd 
Reactor.sd 

Специфический атрибут Значение 

SAObjectType Reactor 

SATopology 
 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.3.12. Выкатная тележка 
 
Таблица 3.3.12.-1 Truck 
 

Имя файла 

 
Truck H.sd 
Truck.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выкачена, 
2=Вкачена, 3=Неисправна 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Truck 

SASuperType Switching Device 

SATopology 
 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

ToolLauncherProgId  ControlDlgs.Launcher 
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3.3.13. Командная кнопка 
 
Таблица 3.3.13.-1 Execute button  
 

Имя файла 

 
Execute Button.sd  

Переменная данных Значение 

Executable Text (максимум 256 символов): Путь к 
исполняемому файлу  

Arguments 
Text (максимум 256 символов): 
Аргументы, передаваемые исполняемому 
файлу в командной строке 

Caption Text (максимум 16 символов): Надпись, 
показываемая символом 

Специфический атрибут Значение 

SAObjectType Execute Button 
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3.4. SA-символы IEC 
 
3.4.1. Выключатель 
 
Таблица 3.4.1.-1 Circuit Breaker 
 

Имя файла 

 
Breaker H.sd 
Breaker.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Breaker 

SARepresentation IEC 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.4.2. Контактор 
 
Таблица 3.4.2.-1 Contactor 
 

Имя файла 

 
Contactor H.sd 
Contactor.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Contactor 

SARepresentation IEC 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.4.3. Разъединитель 
 
Таблица 3.4.3.-1 Disconnector 
 

Имя файла 

 
Disconnector H.sd 
Disconnector.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Disconnector 

SARepresentation IEC 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.4.4. Выключатель нагрузки 
 
Таблица 3.4.4.-1 Load Breaker 
 

Имя файла 

 
Load Breaker H.sd   
Load Breaker.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Load Breaker 

SARepresentation IEC 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

 

 58



MicroSCADA Pro SYS 600 *9.1 
Создание экранов процесса 
Инструкция по конфигурации  Версия Candidate Release 1.1 

  
 
3.4.5. 2-x обмоточный трансформатор 
 
Таблица 3.4.5.-1 2-Winding Transformer 
 

Имя файла 

 
Transformer2w H.sd  
Transformer2w.sd 

Переменная данных Значение 

Tap Changer Value Float: Положение отпайки РПН 

Primary Color  Float: Clut-индекс 0…255 

Secondary Color  Float: Clut-индекс 0…255 

Primary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Secondary Voltage Level 
(kV) Float: Уровень напряжения в киловольтах

Primary Tap Changer Float: 0=Видим, 1=Невидим 

Secondary Tap Changer Float: 0=Видим, 1=Невидим 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType 2-Winding Transformer 

SARepresentation IEC 

SASuperType Transformer 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.4.6. 3-x обмоточный трансформатор 
 
Таблица 3.4.6.-1 3-Winding Transformer 
 

Имя файла 

 
Transformer3w H.sd  
Transformer3w.sd 

Переменная данных Значение 

Tap Changer Value Float: Положение отпайки РПН 

Primary Color  Float: Clut-индекс 0…255 

Secondary Color  Float: Clut-индекс 0…255 

Tertiary Color  Float: Clut-индекс 0…255 

Primary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Secondary Voltage Level 
(kV) Float: Уровень напряжения в киловольтах

Tertiary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType 3-Winding Transformer 

SARepresentation IEC 

SASuperType Transformer 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.5. SA-символы ANSI 
 
3.5.1. Выключатель 
 
Таблица 3.5.1.-1 Circuit Breaker 
 

Имя файла 

 
Breaker H.sd 
Breaker.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Breaker 

SARepresentation ANSI 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

 

 61



MicroSCADA Pro SYS 600 *9.1 
Создание экранов процесса 
Инструкция по конфигурации  Версия Candidate Release 1.1 

  
3.5.2. Разъединитель 
 
Таблица 3.5.2.-1 Disconnector 
 

Имя файла 

 
Disconnector H.sd 
Disconnector.sd 

Переменная данных Значение 

Position Float: 0=Промежуточное, 1=Выключен, 
2=Включен, 3=Неисправен 

Status Color  Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Disconnector 

SARepresentation ANSI 

SASuperType Switching Device 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 

 

 62



MicroSCADA Pro SYS 600 *9.1 
Создание экранов процесса 
Инструкция по конфигурации  Версия Candidate Release 1.1 

  
3.5.3. 2-x обмоточный трансформатор 
 
Таблица 3.5.3.-1 2-Winding Transformer 
 

Имя файла 

 
Transformer2w H.sd  
Transformer2w.sd 

Переменная данных Значение 

Tap Changer Value Float: Положение отпайки РПН 

Primary Color  Float: Clut-индекс 0…255 

Secondary Color  Float: Clut-индекс 0…255 

Primary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Secondary Voltage Level 
(kV) Float: Уровень напряжения в киловольтах

Primary Tap Changer Float: 0=Видим, 1=Невидим 

Secondary Tap Changer Float: 0=Видим, 1=Невидим 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType 2-Winding Transformer 

SARepresentation ANSI 

SASuperType Transformer 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.5.4. 3-x обмоточный трансформатор 
 
Таблица 3.5.4.-1 3-Winding Transformer 
 

Имя файла 

 
Transformer3w H.sd  
Transformer3w.sd 

Переменная данных Значение 

Tap Changer Value Float: Положение отпайки РПН 

Primary Color  Float: Clut-индекс 0…255 

Secondary Color  Float: Clut-индекс 0…255 

Tertiary Color  Float: Clut-индекс 0…255 

Primary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Secondary Voltage Level 
(kV) Float: Уровень напряжения в киловольтах

Tertiary Voltage Level (kV) Float: Уровень напряжения в киловольтах

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType 3-Winding Transformer 

SARepresentation ANSI 

SASuperType Transformer 

SATopology 
 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
 

SAOrientation Horizontal/Vertical 
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3.6. SA-символы индикации 
 
3.6.1. Индикатор АПВ (Дискретный вход) 
 
Таблица 3.6.1.-1 Auto-Reclosing Tag (Binary Input) 
 

Имя файла 

 
Auto-Reclosing BI.sd  

Переменная данных Значение 

Value Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Auto-Reclosing Tag  

SANoRotate 
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3.6.2. Индикатор АПВ 
 
Таблица 3.6.2.-1 Auto-Reclosing Tag  
 

Имя файла 

 
Auto-Reclosing.sd  

Переменная данных Значение 

Value 1 Float: 0=Видим, 1=Невидим 

Value 2 Float: 0=Видим, 1=Невидим 

Value 3 Float: 0=Видим, 1=Невидим 

Value 4 Float: 0=Видим, 1=Невидим 

Value 5 Float: 0=Видим, 1=Невидим 

Value 6 Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Auto-Reclosing Tag  

SANoRotate 
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3.6.3. Присоединение (Дискретный вход)  
 
Таблица 3.6.3.-1 Bay (Binary Input) 
 

Имя файла 

 
Bay BI.sd  

Переменная данных Значение 

State Signal Float: 0=Местное, 1=Дистанционное 

Status Color Float: Clut-индекс 0…255 

Caption Text: Надпись, показываемая в верхней 
части символа 

Специфический атрибут Значение 

SAObjectType Bay 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.6.4. Присоединение  
 
Таблица 3.6.4.-1 Bay  
 

Имя файла 

 
Bay.sd  

Переменная данных Значение 

State Signal Float: 0=Выведено, 1=Местное, 
2=Дистанционное, 3=Нет 

Status Color Float: Clut-индекс 0…255 

Caption Text: Надпись, показываемая в верхней 
части символа 

Специфический атрибут Значение 

SAObjectType Bay 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.6.5. Станция (Дискретный вход)  
 
Таблица 3.6.5.-1 Station (Binary Input) 
 

Имя файла 

 
Station BI.sd  

Переменная данных Значение 

State Signal Float: 0=Дистанционное, 1=Станция 

Status Color Float: Clut-индекс 0…255 

Caption Text: Надпись, показываемая в верхней 
части символа 

Специфический атрибут Значение 

SAObjectType Station 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.6.6. Станция  
 
Таблица 3.6.6.-1 Station  
 

Имя файла 

 
Station.sd  

Переменная данных Значение 

State Signal Float: 0=Местное, 1=Станция, 
2=Дистанционное, 3=Нет 

Status Color Float: Clut-индекс 0…255 

Caption Text: Надпись, показываемая в верхней 
части символа 

Специфический атрибут Значение 

SAObjectType Station 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.6.7. Индикатор отключения 
 
Таблица 3.6.7.-1 Tripping Tag 
 

Имя файла 

 
Tripping.sd  

Переменная данных Значение 

Trip Signal Float: Clut-индекс 0…44=Невидим,  
45..46= Видим, 47…255=Невидим 

Caption Text: Надпись, показываемая символом 

Специфический атрибут Значение 

SAObjectType Tripping Tag 

SANoRotate 
 
 

 
3.6.8. Индикатор тревоги 
 
Таблица 3.6.8.-1 Alarm Indicator A 
 

Имя файла 

 
Alarm A.sd  

Переменная данных Значение 

Bounding Box Float: 0=Видим, 1=Невидим 

Status Color Float: (Clut-индекс 0-255) 

Специфический атрибут Значение 

SAObjectType Alarm Indicator 

SARepresentation A 
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Таблица 3.6.8.-2 Alarm Indicator Bell 
 

Имя файла 

 
Alarm Bell.sd   

Переменная данных Значение 

Bounding Box Float: 0=Видим, 1=Невидим 

Status Color Float: (Clut-индекс 0-255) 

Специфический атрибут Значение 

SAObjectType Alarm Indicator 

SARepresentation Bell 

 
Таблица 3.6.8.-3 Alarm Indicator Led 
 

Имя файла 

 
Alarm Led.sd   

Переменная данных Значение 

Bounding Box Float: 0=Видим, 1=Невидим 

Status Color Float: (Clut-индекс 0-255) 

Специфический атрибут Значение 

SAObjectType Alarm Indicator 

SARepresentation Led 
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Таблица 3.6.8.-4 Alarm Indicator Star 
 

Имя файла 

 
Alarm Star.sd   

Переменная данных Значение 

Bounding Box Float: 0=Видим, 1=Невидим 

Status Color Float: (Clut-индекс 0-255) 

Специфический атрибут Значение 

SAObjectType Alarm Indicator 

SARepresentation Star 
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3.7. SA-символы измерений 
 
3.7.1. Диаграмма 
 
Display Builder предоставляет возможность создания нескольких 
различных типов объектов, которые используются для отображения 
диаграмм. Два типа графов доступны как объекты-символы. Они могут 
применяться в однолинейных схемах или встраиваться в другие 
аналитические приложения. 
 
Таблица 3.7.1.-1 Bar Graph 
 

Имя файла 

 
Bar Graph.sd  

Переменная данных Значение 

Value Float: Измеренное значение 

Max Float: Максимальный уровень 

High Alarm  Float: Верхний аварийный уровень   

High Warning Float: Верхний предупредительный 
уровень 

Low Warning Float: Нижний предупредительный 
уровень 

Low Alarm Float: Нижний аварийный уровень 

Min Float: Минимальный уровень 

Специфический атрибут Значение 

SAObjectType Measurement Bar 

SASuperType Measurement 

SARepresentation Bar Graph 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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Таблица 3.7.1.-2 Line Graph 
 

Имя файла 

 
Line Graph.sd  

Переменная данных Значение 

Value Float: Измеренное значение 

Max Float: Максимальный уровень 

High Alarm  Float: Верхний аварийный уровень   

High Warning Float: Верхний предупредительный 
уровень 

Low Warning Float: Нижний предупредительный 
уровень 

Low Alarm Float: Нижний аварийный уровень 

Min Float: Минимальный уровень 

Специфический атрибут Значение 

SAObjectType Measurement Bar 

SASuperType Measurement 

SARepresentation Line Graph 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.7.2. Числовое значение 
 
Таблица 3.7.2.-1 Value 
 

Имя файла 

 
Value.sd  

Переменная данных Значение 

Value Float: Измеренное значение 

Unit Text: Единица измерения 

Специфический атрибут Значение 

SAObjectType Measurement Value 

SASuperType Measurement 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate 
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3.7.3. Символ 
 
Таблица 3.7.3.-1 Circle 
 

Имя файла 

 
Circle.sd   

Переменная данных Значение 

Status Color Float: Clut-индекс 0…255 

Caption Text: Надпись, показываемая символом 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Measurement Symbol 

SARepresentation Circle 

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate  
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Таблица 3.7.3.-2 Current Transducer ANSI 
 

Имя файла 

 
Current Transducer ANSI H.sd  
Current Transducer ANSI.sd   

Переменная данных Значение 

Status Color Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Measurement Symbol 

SARepresentation Current Transducer ANSI 

SATopology  

SASnapToMiddle  

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate  

SAOrientation Horizontal/Vertical 
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Таблица 3.7.3.-3 Current Transducer IEC 
 

Имя файла 

 
Current Transducer IEC H.sd  
Current Transducer IEC.sd   

Переменная данных Значение 

Status Color Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Measurement Symbol 

SARepresentation Current Transducer IEC 

SATopology  

SASnapToMiddle  

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate  

SAOrientation Horizontal/Vertical 
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Таблица 3.7.3.-4 Voltage Transducer ANSI 
 

Имя файла 

 
Voltage Transducer ANSI H.sd  
Voltage Transducer ANSI.sd   

Переменная данных Значение 

Status Color Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Measurement Symbol 

SARepresentation Voltage Transducer ANSI 

SATopology  

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate  

SAOrientation Horizontal/Vertical 
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Таблица 3.7.3.-5 Voltage Transducer IEC 
 

Имя файла 

 
Voltage Transducer IEC H.sd  
Voltage Transducer IEC.sd   

Переменная данных Значение 

Status Color Float: Clut-индекс 0…255 

Bounding Box Float: 0=Видим, 1=Невидим 

Специфический атрибут Значение 

SAObjectType Measurement Symbol 

SARepresentation Voltage Transducer IEC 

SATopology  

ToolLauncherProgId  ControlDlgs.Launcher 

SANoRotate  

SAOrientation Horizontal/Vertical 
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4. Функциональность библиотеки SA 
 
4.1. О данном разделе 
 
Этот раздел предоставляет общую информацию о функциональности 
символов библиотеки SA. 
 
4.2. Задание для объектов имен по умолчанию 
 
Display Builder позволяет присваивать имена по умолчанию всем 
объектам, которые отображаются через OPC при сохранении экрана 
или при выборе меню Actions > Create Default Names for Objects. 
Для активизации данной функции следует выбрать опцию Create 
Default Names for Objects on Save в меню Actions и подтвердить 
выполнение команды в окне сообщения. Проделанная операция не 
может быть отменена. Display Builder создаст имена по умолчанию на 
основе OPC-тэгов объектов и автоматически запишет их в свойства этих 
объектов. 
 
4.3. Создание файла импорта в DMS 
 
Когда процесс создания экрана завершен, вся информация о 
конфигурации систем шин, коммутационных аппаратов, измерениях, 
символах индикации и других объектах, а также о взаимосвязях между 
ними и отображении сигналов, сохраняется в файле экрана (.v). 
Сохраненная информация может быть передана в DMS. Для этой цели 
Display Builder создает трансфер-файл, который непосредственно 
импортируется в DMS.  
 
Импортируемый файл сохраняется в формате SYS 600 Impor  Graphics 
.is6g в том же каталоге, где находится файл экрана. 

t

 
Чтобы создать файл импорта в DMS следует: 
 

1. Выбрать пункт меню Actions > Build DMS Import File или 
2. Выбрать пункт меню Actions > Options > Build DMS Import File 

on Save и выполнить сохранение файла экрана. 
 
Display Builder также может предать созданный файл импорта в DMS 
600 Network Editor. Эта процедура выполняется автоматически при 
создании файла, если была выбрана опция  Actions > Options > Send 
DMS Import File to Network Editor after Biuld. 
 
Опция передачи файла может быть выбрана, если установлена система 
DMS 600 *4.0 или более поздней версии. Тем не менее, файл импорт 
может быть создан всегда, в независимости от установки DMS 600. 
Более детальная информация об импорте фалов экранов в DMS 600 и 
формате .is6g приведена в документе DMS 600 System Administration. 
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4.4. Динамическая окраска шин 
 
Функция динамической окраски шин используется в SYS 600 Monitor Pro 
и Display Builder для отображения текущего состояния сегмента шин 
несколькими различными способами. Функция может информировать о 
том, находится ли сегмент шин под напряжением, без напряжения или 
в каком-то ином состоянии, либо окрашивать сегмент в зависимости от 
уровня напряжения. Альтернативный вариант допускает возможность 
задания определенного цвета источнику питания и окраску шин в 
зависимости от того, каким источником они запитаны. 
 
Чтобы задать настройки функции окраски шин следует выбрать пункт 
меню Actions > Busbar Coloring. Будет отображено диалоговое окно, 
показанное ниже. 
 

 
 
Рис. 4.4.-1 Диалоговое окно Busbar Coloring Se ings  tt
 
На закладке General определяются настройки функции динамической 
окраски шин, используемые в текущем экране. Данные настройки могут 
быть сохранены в качестве настроек по умолчанию при помощи кнопки 
Set as defaults. Исходные настройки по  умолчанию 
восстанавливаются кнопкой Restore defaults. 
 
На закладке Coloring Modes выбирается режим окраски, используемый 
Display Builder для сегментов шин, находящихся под напряжением.  
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Рис. 4.4.-2 Режим окраски 
 
На закладке Colors задается приоритет для различных источников 
напряжения. Устройство с наивысшим приоритетом находится вверху 
списка. Чтобы изменить приоритет устройства следует выбрать его из 
списка и переместить в нужное положение при помощи кнопок со 
стрелками. 
 

 
 
Рис. 4.4.-3 Приоритет источников напряжения  
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На рисунках 4.4.-4 и 4.4.-5 представлены примеры экранов процесса 
без использования и с использованием функции динамической окраски 
шин.  
 

 
 
Рис. 4.4.-4 Изображение подстанции с отключенной окраской шин      
 

  
Рис. 4.4.-4 Изображение подстанции со включенной окраской шин      
 
Для того чтобы использовать функцию динамической окраски шин, 
файл экрана процесса должен хранить следующую информацию: 
 
• Уровень напряжения должен быть определен для всех объектов, 

являющихся источниками напряжения. Display Builder может 
выполнять проверку данного условия при сохранении файла 
экрана, см. раздел 4.4.1. 

• Все объекты, являющиеся частью топологии функции окраски шин, 
должны иметь уникальный идентификатор и содержать 
информацию о том, к каким объектам они подключены. Эта 
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информация может быть задана вручную, но в большинстве 
случаев, она генерируется автоматически.  

• Все динамические объекты,  являющиеся частью топологии 
функции окраски шин, должны хранить ID той точки в источнике 
данных MicroSCADA, к которой они подключены. ID храниться в 
специальном ключе-атрибуте OPCItemID. Ключ и его значение 
генерируются автоматически из переменной данных в процессе 
сохранения файла экрана. 

 
Объекты типа примитивная линия могут использоваться 
вместо символов шин. Функция динамической окраски шин 
обрабатывает оба типа этих объектов идентично.  

 
4.4.1. Уровень напряжения 
 
Уровень напряжения должен быть определен для всех объектов, 
выступающих в качестве источника напряжения. Такими объектами 
являются индикатор линии, трансформатор и генератор. 
Поддерживаемые уровни напряжения перечислены далее. Если будет 
задано отличное от приведенных значение, функция окраски шин 
округлит это значение до ближайшего, например значение 120 kV 
будет интерпретировано как 110 kV. 
 
Поддерживаемые уровни напряжения: 
 
Таблица 4.4.1.-1 Уровни напряжения  
 

0 kV 15 kV 66 kV 220 kV 

3 kV 20 kV 110 kV 400 kV 

6 kV 30 kV 132 kV 800 kV 

10 kV 45 kV 150 kV 1600 kV 

 
Уровень напряжения задается путем сопоставления следующих 
переменных данных константным величинам в киловольтах: 
 
• Индикаторы линий: Voltage Level (kV) 
• 2-х обмоточные трансформаторы: Primary Voltage Level (kV) и 

Secondary Voltage Level (kV) 
• 3-х обмоточные трансформаторы: Primary Voltage Level (kV), 

Secondary Voltage Level (kV) и Tertiary Voltage Level (kV) 
• Генераторы: Voltage Level (kV) 

 
Чтобы сопоставить переменную данных константе в киловольтах 
следует: 
 

1. Выбрать объект и выбрать опцию Select > Properties. 
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2. Перейти на закладку Subdrawing. 
3. Установить Mapping Type в значение Map to Constant 
4. Ввести значение в столбце Is Mapped To 

 

 
 

     
 

 

Рис. 4.4.1.-1. Отображение уровня напряжения индикатора линии
значению 110 киловольт

Выполнить проверку условия, что все уровень напряжения был 
определен для всех объектов можно при помощи меню Actions > 
Check Voltage Levels. Если была выбрана опция Check Voltage Level 
on Save (см. раздел 4.7) и выполняется сохранение экрана, для каждого 
объекта с незаданным уровнем напряжения будет показано диалоговое 
окно, приведенное ниже. Модно пропустить операцию отображения 
путем нажатия копки Skip или Skip All. 
 
Требуемый уровень напряжения определяется посредством выбора 
значения из выпадающего списка в поле Variable Mapping. 
 
Имя переменной данных отображается красным цветом, если введено 
недопустимое значение. Цвет меняется на черный, когда уровень 
напряжения определен верно. Кнопка OK недоступна пока введено 
недопустимое значение.  
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.    
 
Рис 4.4 1.-2 Определение уровня напряжения 

4.4.2. Формирование топологии 
 
Функция динамической окраски шин требует наличия уникальных 
идентификаторов для всех объектов в топологии. При создании 
объекта, который может быть частью топологии, идентификатор 
автоматически генерируется и сохраняется в специальном атрибуте-
ключе SAObjectName. Если такой ключ не существует, то он и его 
значение могут быть созданы путем выбора меню Actions > Add 
Selected Objects to Topology. 
 
Если была выбрана опция Actions > Add Selected Objects to 
Topology by Defaults, все объекты, которые могут входить в 
топологии, получают также специальные атрибуты-ключи для хранения 
информации о соединениях. Данные ключи именуются NextObject1, 
NextObject2 и так далее в зависимости от того, сколько соединений 
объект может иметь. Если ключи не существуют, они создаются 
командой Actions > Add Selected Objects to Topology. 
 
Ключи их значения могут быть удалены при помощи пункта меню 
Actions > Remove Selected Objects to Topology. Значения ключей 
задаются вручную или генерируются автоматически при выборе меню 
Actions > Build Topology. Каждое значение содержит SAObjectName, 
двоеточие и количество точек привязки (hotspot), к которым объект 
подключен. Если точное значение привязок не может быть указано, то 
для шин применяется 0. 
 
Соединение объектов в топологию, также как функции Snap to Symbol и 
Snap and Stretch to Symbol, базируется на использовании невидимых 
точек присоединения, называемых точками привязки (hotspot). Все SA-
символы, которые могут входить в топологию, содержат от 1 до 5 точек 
привязки. Кроме того, оба конца примитивной линии также  
интерпретируются Display Builder как точки привязки. На рис. 4.4.2.-1 
точки привязки символа выключателя указаны серными стрелками.  
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Рис. 4.4 2.-1 Точки привязки символа выключателя.     
 
4.4.3. Информация о топологии 
 
Чтобы отобразить информации о текущей топологии схемы следует 
выбрать пункт меню Actions > Topology Information. В открывшемся 
диалоговом окне будут отображены все параметры объектов экрана, 
см. Рис. 4.4.3.-1. 
 
В разделе Options задается режим отображения информации. 
 
• Опция Objects in Topology задает режим вывода только тех 

объектов, которые входят в топологию. 
• Опция Objects NOT in Topology задает режим вывода только тех 

объектов, которые не входят в топологию. 
• Опция Connected Objects выводит список объектов, у которых 

присоединены все точки привязки. 
• Опция Unconnected Objects выводит список объектов, у которых не 

присоединена одна или более точка привязки. Следует заметить, 
что сборные шины всегда показываются в этой категории, 
поскольку они не имеют присоединенных объектов по концам, 
однако это не означает, что топология сформирована неверно 

• Опция Manually Connected Objects задает режим вывода объетов, 
которые имеют специфические атрибуты LockNextObject1, 
LockNextObject2 и.т. Атрибут LockNextObject должен быть 
добавлен, если значение ключа NextObject было введено вручную 
и функция динамической окраски шин не должна изменять это 
значение в дальнейшем.  

• Опция Full Topology Details выводит всю доступную информацию 
по всем объектам экрана. 

 
Кнопка Refresh обновляет информацию и выводит ее повторно. 
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Рис. 4.4 3.-1 Отображение информации о топологии схемы.    
 

t

4.5. Браузер объектов 
  
Браузер объектов отображает иерархию объектов процесса для 
выбранного приложения.  
 
Чтобы открыть браузер объектов следует: 
 

1. Выбрать пункт меню Actions > Object Browser. Будет показано 
диалоговое окно Objec  Browser. 

2. Выбрать приложение из выпадающего списка.     
3. Нажать Select. В окне будет показана иерархия объектов 

процесса. 
 

Браузер объектов поддерживает функциональность drag & drop для 
перетаскивания объектов в область рисования, что аналогично 
операции выбора объекта и нажатию кнопки Create. При выполнении 
описанных выше действий будут созданы соответствующий символ и 
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переменные данных в источнике данных MicroSCADA. Переменные 
символа будут автоматически сопоставлены переменным данных 
источника. Для некоторых объектов существует возможность выбора 
горизонтальной или вертикальной ориентации символа. Чтобы выбрать 
представление для создаваемого объекта, следует выбрать 
соответствующее значение из выпадающего меню в нижней части окна 
браузера объектов (см. Рис. 4.5.-1). 
 
Окно браузера объектов может быть пристыковано к правой стороне 
области рисования, таким образом чтобы сливаться с окном Display 
Builder. Это позволяет перетаскивать объекты из браузера без 
необходимости перемещения его окна. 
 

   
          
Рис. 4.5.-1 Браузер объектов  
 
Браузер объектов создает переменные автоматически. Кроме того, он 
задает тип открываемого для символа диалога управления.  
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4.6. Логические цвета и Color Setting Tool 
 
В экранах процесса SYS 600 используется цветовая палитра из 256 
цветов, которые могут выбираться из различных 16k RGB значений. 
Значения RGB сохраняются в .clut (Color LookUp Table) файлах. По 
умолчанию используется файл SYS 600_colors.clut. Когда цвет 
присваивается некоторому объекту, в действительности Display Builder 
присваивает только индекс цвета. Значения RGB для индексов цвета 
считываются каждый раз при запуске Display Builder. Clut-файл может 
быть выбран в диалоговом окне Preferences, но некоторые значения 
RGB можно изменить при помощи Color Setting Tool.  
 
Индексы цвета распределены следующим образом: 
 
• от 16 до 31 – общие цвета экрана и объектов 
• от 32 до 55 – используются для отображения статуса устройств в 

режиме исполнения Display Builder и SYS 600 Monitor Pro 
• от 56 до 95 – используются для окраски шин 

 
Цвета шин имеют следующие назначения: 
 
• от 56 до 63 – общие цвета окраски шин 
• от 64 до 71 – цвета специфичные для разных источников 

напряжения 
• от 72 до 79 – настраиваемые пользователем цвета источников 

напряжения 
• от 80 до 95 – цвета, определяющие различные уровни напряжения 

 
Color Setting Tool используется для изменения RGB значений логических 
цветов. Инструмент открывается посредством меню Actions > Color 
Setting Tool. Диалоговое окно инструмента содержит закладки для 
определения цвета состояния объектов, окраски шин и различных 
цветов общего назначения. Закладка цветов окраски шин содержит 
категории, определяющие общие цвета шин, цвета различных 
источников напряжения и цвета различных уровней напряжения. 
 
Все логические цвета отображаются в виде цветных прямоугольников, 
напротив которых приведены соответствующие RGB значения. Нажатие 
на цветной прямоугольник приведет к открытию диалога Colo  Selection 
для выбора нового RGB значения. Нажатие кнопки Restore Defaults 
выполнит операцию восстановления цветов, используемых SYS 600 по 
умолчанию. Кнопка OK выполняет сохранение изменений и закрытие 
инструмента. Кнопка Cancel закрывает инструмент без сохранения 
изменений.  

r
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Рис. 4.6.-1 Диалоговое окно Color Setting Tool   
 

другим п

Допускается одновременное открытие только одного 
экземпляра Color Setting Tool для редактирования одного  
clut-файла. Если открываемый файл уже редактируется 
ользователем, появиться сообщение, что данный файл 

заблокирован и Color Setting Tool открыт не будет. 
  
Индексы цвета от 16 до 95 зарезервированы для логических цветов. 
Цвет фона для всплывающего сообщения подсказки имеет индекс 1. 
Подробная информация о логических цветах приведена в таблице   
4.6.-1 ниже. 
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Таблица 4.6.-1 Индексы цвета 
 

Индекс Имя Использование 

1 Tooltip  Цвет фона всплывающей 
подсказки 

Различные и общее цвета 16-31 

16 Frame Highlight Светлая рамка вокруг 
некоторых символов SA 

17 Frame Shadow Темная рамка вокруг 
некоторых символов SA 

18  (зарезервировано для 
использования в будущем) 

19  Bounding Box Фоновый прямоугольник 
большинства символов SA  

20 Unmapped Primary Winding 
Цвет символа первичной 
обмотки трансформатора, 
не имеющей сопоставления

21 Unmapped Secondary Winding 
Цвет символа вторичной 
обмотки трансформатора, 
не имеющей сопоставления

22 Unmapped Tertiary Winding 
Цвет символа третичной 
обмотки трансформатора, 
не имеющей сопоставления

23 Display Background Цвет по умолчанию для 
нового экрана 

24 Measurement Low Alarm 

Цвет индикатора 
измерения, когда значение 
опустилось ниже уровня 
тревоги   

25 Measurement Low Warning 

Цвет индикатора 
измерения, когда значение 
опустилось ниже уровня 
предупреждения  

26  Measurement Normal 

Цвет индикатора 
измерения, когда значение 
находится в нормальных 
пределах 

27 Measurement High Warning 

Цвет индикатора 
измерения, когда значение 
поднялось выше уровня 
предупреждения  

28  Measurement High Alarm 

Цвет индикатора 
измерения, когда значение 
поднялось выше уровня 
тревоги  
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Таблица 4.6.-1 Индексы цвета (продолжение) 
 

Индекс Имя Использование 

29 Unmapped device Цвет не сопоставленного 
устройства 

30 Text Цвет по умолчанию для 
новых текстовых объектов 

31 New object Общий цвет для новых 
объектов 

Цвета состояния 32-55 

32 Normal Норма 

33 OPC Quality Bad  OPC-тэг недостоверен 

34 Blocked Блокировано 

35  Invalid value Неверное значение 

36 Historical Data Ретроспективные данные 

37 Manually Entered Введено вручную 

38 Not Sampled Не выбрано 

39 Not Updating Не обновлено 

40  Obsolete Value Устаревшее значение 

41 Selected Выбрано 

42 Selected, Under Command 
(Blinking)  

Выбрано, управляется 
(мигание) 

43 Substituted Заменено 

44 Warning Предупреждение 

45 Alarm Тревога 

46 Alarm, Unacknowledged 
(Blinking) 

Тревога, неквитированная 
(мигает) 

47 Control Blocked Управление блокировано 
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Таблица 4.6.-1 Индексы цвета (продолжение) 
 

Индекс Имя Использование 

48  (зарезервировано для 
использования в будущем) 

49  (зарезервировано для 
использования в будущем) 

50  (зарезервировано для 
использования в будущем) 

51  (зарезервировано для 
использования в будущем) 

52  (зарезервировано для 
использования в будущем) 

53  (зарезервировано для 
использования в будущем) 

54  (зарезервировано для 
использования в будущем) 

55  (зарезервировано для 
использования в будущем) 

Окраска шин 56-95 

56 Uncertain Неопределенное состояние 

57 Unpowered Секция без напряжения 

58 Earthed Секция заземлена 

59 Looped Питание закольцовано 

60 Powered Цвет по умолчанию для 
секции под напряжением 

61 Error 
Ошибочное состояние, 
например, заземлена 
секция под напряжением 

62  Цвет секции, когда окраска 
шин отключена 

63  (зарезервировано для 
использования в будущем) 

Цвета источников напряжения 

64 Generator Секция, подключенная к 
генератору 

65 Incoming Line Indicator Секция, подключенная к 
входящему фидеру 
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Таблица 4.6.-1 Индексы цвета (продолжение) 
 

Индекс Имя Использование 

66 Outgoing Line Indicator Секция, подключенная к 
отходящему фидеру 

67 Primary Transformer Winding 
Секция, подключенная к 
первичной обмотке 
трансформатора 

68 Secondary Transformer 
Winding 

Секция, подключенная к 
вторичной обмотке 
трансформатора 

69 Tertiary Transformer Winding 
Секция, подключенная к 
третичной обмотке 
трансформатора 

70 Rear Feed На секции реверс 
мощности 

   

Цвета источников напряжения, задаваемые пользователем 

72 Powered 1 Под напряжением 1  

73 Powered 2 Под напряжением 2  

74 Powered 3 Под напряжением 3 

75 Powered 4 Под напряжением 4  

76 Powered 5 Под напряжением 5 

77  (зарезервировано для 
использования в будущем) 

78  (зарезервировано для 
использования в будущем) 

79  (зарезервировано для 
использования в будущем) 

Цвета для уровней напряжения 

80 0 kV  

81 3 kV  

82 6 kV  
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Таблица 4.6.-1 Индексы цвета (продолжение) 
 

Индекс Имя Использование 

83 10 kV  

84 15 kV  

85 20 kV  

86 30 kV  

87 45 kV  

88 66 kV  

89 110 kV  

90 132 kV  

91  150 kV  

92 220 kV  

93 400 kV  

94 800 kV  

95 1600 kV  

 
Все цвета источников напряжения, задаваемые 
пользователем, могут быть присвоены любым источникам 
напряжения. Цвета уровней напряжения используются для 
соответствующего режима окраски шин. 

 
4.7. Опции по умолчанию 
 
Меню Actions содержит ряд выбираемых опций, которые активизируют 
действия, выполняемые Display Builder автоматически. Опции 
выбираются путем установки отметки в меню Actions > Options > 
[имя опции]. Выбранная опция будет активна до тех пор, пока не 
будет явно снята. 
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Create Default Name for Objects on Save: 

 
Когда выбрана данная опция, в процессе сохранения экрана 
Display Builder создает имена по умолчанию для всех объектов, 
которые отображаются через OPC. 
 

 Build DMS Import File on Save: 
 

Когда выбрана данная опция, в процессе сохранения файла 
экрана генерируется файл импорта, который позволяет 
импортировать экран процесса в DMS 600. Файл импорта 
сохраняется в одном каталоге с файлом экрана. 

 
 Send DMS Import File to Network Editor after Build: 
 

Когда выбрана данная опция, Display Builder автоматически 
посылает созданный файл импорта в редактор DMS 600 
Network Editor. Данная опция должна выбираться, если 
установлен пакет DMS 600 *4.0 или более поздней версии. 

 
Check Voltage Levels on Save: 

 
Когда выбрана данная опция, Display Builder проверяет уровни 
напряжения при сохранении экрана. Если для каких-то 
объектов уровень напряжения не задан или задан некорректно, 
Display Builder предложит выполнить такую операцию. Более 
подробно этот вопрос описан в разделе 4.4.1. 

 
  Build Topology on Save: 
 

Когда выбрана данная опция, Display Builder автоматически 
генерирует значения для ключей NextObject1, NextObject2 и 
т.д. 

 
 Add Object to Topology by Default: 
 

Все новые объекты будут по умолчанию включаться в 
топологию схемы. 

 
 Double Click Action: 
 

Определяет режим использования двойного щелчка мышью по 
объекту. Двойной щелчок левой кнопкой мыши может 
открывать диалоговое окно Object Properties или присоединять 
символ к ближайшему объекту. 
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5. Свойства динамических данных  
 
Display Builder позволяет пользователю создавать и контролировать 
динамические объекты – графические компоненты, которые могут 
изменяться в результате изменения некоторых данных. К таким 
объектам относятся графы, символы, объекты, изменяющие свою 
геометрию, размер, положение или атрибуты, объекты ввода данных, 
принимающие информацию от оператора, а также объекты, 
обрабатываемые топологией сети. В то время как динамические 
компоненты отображают некую изменяющуюся информацию, 
статическая часть экрана предоставляет фоновое изображение или 
некоторый дополнительный контекст. 
 
Чтобы отобразить изменения в данных посредством динамических 
объектов, Display Builder должен сначала выбрать данные из некоторого 
источника, временно сохранить их и затем отобразить при помощи 
динамических компонентов. Выборка и хранение данных описываются 
путем выбором источника данных и переменных данных 
соответственно. Источник данных определяет, где данные могут быть 
получены, например из файла. Переменные данных детально 
описывают представление этих данных. 
 
5.1. О данном разделе 
 
Данный раздел описывает выполнение расширенных операций, 
связанных с источниками данных, переменными данных, объектной 
динамикой и правилами. 
 
5.2. Источники данных 
 
Источник данных – это некоторый единичный источник входящих 
данных. Display Builder может использовать входные данные, 
сохраненные в файле, полученные в результате взаимодействия с 
оператором, или данные, представляющие собой набор некоторых 
константных значений. Каждый файл, вывод программы или функции, 
устройство, объект ввода или набор констант рассматривается как один 
источник данных. После определения источника, данные читаются из 
него как числовой поток. Поток может представлять одну или более 
переменных.      
 
Display Builder поддерживает следующие источники данных: 
      
• MicroSCADA 
• Файл 
• Память 
• Константа 

 
Один и тот же файл может одновременно предоставлять данные 
нескольким источникам. Display Builder отслеживает каждый источник 
данных во время исполнения и может открыть столько файлов, сколько 
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будет использоваться. Источники данных могут создаваться, 
модифицироваться и удаляться по мере необходимости. Однако, 
источник данных невозможно удалить, если его переменных связаны с 
некоторыми объектами или функциями. Чтобы сделать это, необходимо 
сначала удалить эти объекты, переменные или функции и лишь затем 
выполнить удаление источника данных. 
 
Пользователь может контролировать какие источники данных 
используются в экране, также как он контролирует графические 
объекты экрана. Главное отличие между ними заключается в том, что 
при добавлении графического объекта в экран, происходит создание 
графического объекта в интерфейсе. При добавлении источника 
данных, пользователь лишь описывает источник данных, который уже 
может существовать. 
 
5.2.1. Создание источника данных 
 
Диалоговое окно Data Selec ion отображается каждый раз, когда 
пользователь явно открывает его, требуется выбрать переменную 
данных, а также добавить или изменить переменную, связанную с 
компонентом Display Builder, таким как динамический объект, 
динамическое свойство или правило. В зависимости от контекста, в 
котором открывается диалог, в нем отображается либо только список 
Data Source List, либо список совместно с данными конфигурации 
справа от него. 

t

      
Чтобы отобразить диалог Data Selection  следует выбрать пункт меню 
Edit > Data Variables.  
 
При выборе в качестве источника данных MicroSCADA существует 
возможность задать период мигания для мигающих цветов, таких как 
цвет неквитированных тревог, путем выбора приложения и ввода 
значения в миллисекундах. 
 
Многие диалоги отображают информацию о присваивании переменных 
данных. Например, переменные графа показываются в диалоговом окне 
Graph Properties, а переменные, связанные с динамикой объекта в окне 
Object Properties. При добавлении или изменении переменных в этом 
окне, диалог Data Selection  будет открыт со скрытой областью 
конфигурации. Чтобы отобразить область конфигурации следует 
воспользоваться кнопкой Edit. 
 
   

 101



MicroSCADA Pro SYS 600 *9.1 
Создание экранов процесса 
Инструкция по конфигурации  Версия Candidate Release 1.1 

  

 
 
Рис. 5 2.1-1 Диалог Data Selec ion. t  
 

t

5.2.2. Редактирование источника данных 
     
Диалоговое окно Data Selec ion  отображает иерархическую структуру 
источников данных и их переменных. Существует возможность 
отображения развернутого списка, состоящего из источников данных и 
переменных или свернутого списка, в котором представлены только 
источники данных. Чтобы свернуть весь список сразу следует 
воспользоваться значком Expand All. Развертка индивидуального 
источника может быть произведена двойным щелчком мыши по его 
имени в общей иерархической структуре. 
 
Чтобы добавить источник данных следует: 
 

1. Открыть диалог Data Selection. 
2. Выбрать тип нового источника данных из выпадающего меню  

New Data Source. Детальное описание типов источников данных 
приведено в разделе 5.2.3. 

3. Нажать кнопку Add New Data Source возле выпадающего меню  
New Data Source. 

 

 102



MicroSCADA Pro SYS 600 *9.1 
Создание экранов процесса 
Инструкция по конфигурации  Версия Candidate Release 1.1 

  
Новый источник данных будет показан в списке источников. 
Константные источники данных показываются в иерархии константных 
источников. 
 
5.2.2.1. Определение формата источника данных 
 
Опция Format указывает, является источник данных источником 
бинарного типа или же он представлен в формате ASCII. Файлы 
источников данных могут содержать данные обоих типов, однако 
смешение типов в одном источнике не возможно. Тем не менее, 
возможно отображать бинарные и ASCII данные в одном и  том же 
графе. 
    
ASCII данные сохраняются в виде данных с плавающей запятой либо 
текстовых строк. Бинарные данные могут храниться как данные с 
плавающей запятой или как целочисленные данные различного 
размера, либо как текстовые строки. Таким образом, бинарный формат 
предоставляет больше возможностей для контроля процесса чтения 
данных. ASCII данные должны преобразовываться во внутренний 
формат представления чисел с плавающей запятой. Поскольку процесс 
преобразования требует дополнительных затрат времени, 
рекомендуется использовать бинарные данные при обработке больших 
файлов или в случае когда важна скорость обработки. 
 
Чтобы определить формат источника данных следует: 
 

1. Открыть диалог Data Selection. 
2. Установить переключатель Format в необходимое положение. 

  
5.2.3. Типы источников данных 
 
Тип источника данных определяет источник используемых данных. 
Источником данных может быть файл, память, константа и MicroSCADA. 
Тип источника не может быть изменен. Чтобы использовать другой тип, 
следует создать новый источник данных с правильным типом.  
 
Поддерживаются следующие типы источников данных:  
 
MicroSCADA: Источник данных MicroSCADA используется для 
установки соединения с MicroSCADA OPC-сервером. Источник данных 
такого типа доступен только для MicroSCADA Pro версии 9.0 или более 
поздней. Источник данных MicroSCADA позволяет использовать 
функциональность библиотеки SA, описанную в разделе 4. 
Использование переменных данных описано в разделе 5.3. 
 
File: Отображает данные, сохраненные в любом файле, для которого 
разрешен доступ на чтение. Display Builder использует файлы с ASCII 
числами, разделенными пробелами, символами табуляции, символами 
перевода строки или файлы с бинарными данными. Текстовые 
переменные должны быть фиксированной длины. 
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Memory: Существует возможность определить источник, получающий 
данные из других источников данных Display Builder. Сюда входят 
источники данных в памяти, используемые объектами ввода и 
объектами управления. Кроме того, возможен программный доступ к 
большому числу различных источников, не доступных при помощи 
редактора. 
 
Constant: Определяет источник данных, содержащий только 
константные значения. Значения задаются при определении констант и 
не изменяются в процессе выполнения экрана. В объектах графов 
константы могут использоваться в качестве относительных точек для 
сравнения других изменяющихся значений. 
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5.3. Переменные данных         
 
Характеристики источника данных описывают сам источник этих 
данных как таковой, переменные данных описывают сами данные: их 
организацию, тип, имя, и в случае константы, ее значение. 
 
5.3.1. Создание переменной данных         
 
Чтобы добавить переменную данных к источнику данных следует: 
 

1. Открыть диалог Da a Selec ion, выбрав меню Edit > Data 
Variables. 

t t

2. Выбрать источник данных из иерархии. 
3. Нажать кнопку New Variable, чтобы выполнить добавление и 

отобразить специфические настройки переменной. 
 

   
Рис. 5.3.1.-1 Добавление новой переменной данных   
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5.3.2. Редактирование переменной данных 
 
Переменные данных выполняют распределение потоков данных, 
поставляемых источниками данных. Распределенные данные 
помещаются в отдельные буферы экрана для предварительной 
обработки. Display Builder позволяет описать организацию данных 
путем определения соответствующих переменных. 
 
5.3.2.1. Определение свойств 
 
Display Builder добавляет переменные данных с использованием свойств 
по умолчанию. Пользователь имеет возможность изменять эти свойства 
и добавлять дополнительные переменные, чтобы добиться 
соответствия свойств и организации данных в их источнике. При 
использовании переменных данных доступно определение следующих 
их свойств: 
 
• Scope: объявляет переменную скрытой (private) или открытой 

(public). Сопоставление возможно лишь для переменных, которые 
были объявлены как открытые в исходном экране, таким образом, 
правильное определение области видимости имеет значение для 
переменных в экранах, которые будут использоваться в качестве 
активных символов. 

• Name: имя переменной или константы. 
• Data type: классификация данных, например текст или целое число. 
• Value: Значение константы в константном источнике данных. 
• Shape: Количество элементов в переменной или константе.    
         
5.3.2.2. Определение имени 
 
Имя переменной используется для идентификации переменной в меню 
Display Builder и легендах графа. Display Builder присваивает 
переменным имена по умолчанию – Var:1, Var:2, Var:3 и т.д., 
последовательно увеличивая номера в соответствии с общим числом 
переменных.  
 
После создания переменной ее имя может быть изменено на другое, 
более содержательное, без влияния на связанный с ней поток данных. 
При редактировании имени переменной в текстовом поле, изменения 
отображаются также в иерархическом дереве источников данных слева. 
Кроме того, изменения отображаются во всех местах, где используется 
имя переменной. 
 
Чтобы задать имя переменной следует: 
 

1. Открыть диалог Da a Selec ion, выбрав меню Edit > Data 
Variables. 

t t

2. Отредактировать имя переменной в поле Name. 
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5.3.2.3. Определение типа 
 
Данные в источнике данных сохраняются в одном из форматов, 
описанных в разделе 5.3.3. Опции, представленные в раскрывающемся 
меню Type, зависят от формата источника данных, к которому 
принадлежит переменная. Источники данных файлового типа 
поставляют данные в формате ASCII либо в бинарном виде. 
 
Если формат данных ASCII, данные интерпретируются как текстовые 
строки или как числа, преобразуемые во внутреннюю форму 
представления чисел с плавающей запятой. Если формат данных 
бинарный, данные могут интерпретироваться как данные одного из 
типов, описанных в разделе 5.3.3. Необходимо заметить, что все 
данные в одном файле должны быть одинакового типа. По умолчанию, 
для как для ASCII, так и для бинарных данных используется  тип Float. 
 
Чтобы определить тип переменной данных следует: 
 

1. Открыть диалог Data Selection. 
2. Выбрать раскрывающееся меню Type. 
3. Установить нужный тип переменной. 

 
5.3.2.4. Определение области видимости 
 
Область видимости переменной (scope) указывает на то,  является 
переменная открытой (public) или закрытой (private). Данная опция 
важна, когда экран используется в качестве активного символа. Только 
открытые переменные символа могут быть сопоставлены константным 
значениям или переменным экрана, содержащего этот символ. 
 
Чтобы определить область видимости переменной следует: 
 

1. Открыть диалог Da a Selec ion, выбрав меню Edit > Data 
Variables. 

t t

2. Установить переключатель Scope в соответствующее положение. 
 

Область видимости по умолчанию Private. 
 
5.3.2.5. Определение значения константной 
переменной данных 
 
Константы – это присвоенные значения, которые не изменяются в 
процессе выполнения экрана. При изменении значения константы, оно 
изменяется во всех связанных местах экрана. Например, если была 
создана константа со значением 2.59, используемая в нескольких 
графах, и ее значение было изменено на 157, каждый граф будет 
использовать значение 157. 
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5.3.2.6. Определение формы переменной данных 
 
Форма переменной данных или константы определяется количеством 
значений данных или элементов. При выборе векторной или матричной 
формы, можно задать количество строк и столбцов в текстовых полях, 
расположенных ниже поля Shape.   
 
Display Builder может использовать следующие формы переменных: 
 
• Scalar: Единственное значение 
• Vector: Одноразмерный массив чисел 
• Matrix: Двуразмерный массив чисел 

 
Форма по умолчанию Scalar. 
 
5.3.2.7. Определение свойств переменной данных 
MicroSCADA 
 
Переменные данных, относящиеся к источнику данных MicroSCADA, 
могут иметь дополнительно настраиваемую функциональность. 
Пользователю дана возможность определить назначение переменной – 
индикация положения, цвет состояния или общий сигнал – в процессе 
сопоставления различных символов экрана объектам процесса. Более 
детальная информация о сопоставлении переменных приведена в 
разделе 5.3.4. 
 
Переменная типа «индикация положения» (State indication) позволяет 
выполнить переключение значений для сигнала положения. Значения 
меняются путем установки переключателя Value swapping for state 
indication в требуемое положение (см. рис. 5.3.1.-1).   
 
5.3.3. Типы переменных данных 
 
Display Builder поддерживает следующие типы переменных данных: 
 
• Float: Число с плавающей точкой. Числа интерпретируются 

корректно, независимо от того, имеют ли они десятичный 
разделитель. 

• Double: Число с плавающей точкой удвоенной точности. 
• Long: Длинное целое, как правило, 4 байта (32 бита), но зависит от 

платформы. 
• Ulong: Unsigned long, беззнаковое длинное целое в диапазоне 

больше нуля, всегда положительное.  
• Short: Короткое целое, как правило, 2 байта (16 бит), но зависит от 

платформы. 
• Ushort: Unsigned short, беззнаковое короткое целое в диапазоне 

больше нуля, всегда положительное.  
• Byte: Целое размером в один байт (8 бит), диапазон принимаемых 

значений -128..127. 
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• Ubyte: An unsigned byte, беззнаковое целое размером в один байт (8 

бит), диапазон принимаемых значений 0..255. 
• Text: Строка символов фиксированной длины. Размер задается 

пользователем. 
 

5.3.4. Сопоставление переменных 
 
При создании символа все источники данных и динамика исходного 
экрана включаются в объект символа. Когда динамика включена, все 
динамические функции символа полностью соответствуют таковым в 
оригинальном экране в режиме исполнения. Нет необходимости 
вносить какие-либо изменения во внутренние переменные символа.    
 
Тем не менее, существует возможность изменить данные, используемые 
символом путем сопоставления его переменных константным значениям 
либо переменным данных текущего экрана. Когда переменная в 
символе отображена (mappped), она использует некоторое заданное 
константное значение либо получает данные из источника в текущем 
экране.  
 
Сопоставление переменных предоставляет следующие возможности: 
 
• Определять какие константные значения или источники данных 

текущего экрана должны управлять динамикой в активном символе. 
• Использовать множественные экземпляры одного символа для 

отображения различных данных. 
• Программно передавать данные символу путем их записи в буферы 

переменных. 
 
Сопоставление возможно только для переменных, объявленных как 
открытые в исходном экране, таким образом, очень важно правильно 
определить область видимости переменной в экране, который 
предполагается использовать в качестве активного символа. 
 
Чтобы сопоставить открытую (public) переменную символа следует: 
 

1. Выбрать объект. 
2. Перейти на закладку Subdrawing в окне Object Properties. 

 
Открытые переменные символа отображаются в секции Variable 
Mapping с указанием сопоставленных им переменных экрана. Столбец 
Mapping Type показывает, сопоставлена переменная в данный момент 
или нет, и предоставляет возможность изменить тип активного 
сопоставления. Столбец Subdrawing Data Variable содержит 
информацию о типе данных для каждой переменной. 
 
Доступны следующие типы сопоставлений: No Mapping (нет 
сопоставления), Map to Constant (сопоставление константе) и Map to 
Variable (сопоставление переменной).      
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Рис 5.3 4.-1 Сопоставление открытых переменных .    
 
Если символ не содержит глобальных переменных, в списке Variable 
Mapping будет показано соответствующее сообщение. Если символ 
содержит глобальные переменные, но они были объявлены закрытыми, 
будет показан пустой список безо всяких сообщений. 
 
Чтобы сопоставить переменную символа константному значению 
следует: 
 

1. Выбрать имя переменной в столбце Subdrawing Data Variable. 
2. В выпадающем меню Mapping Type выбрать тип сопоставления 

Map to Constant.  
3. Ввести значение константы в столбце Is Mapped To. 

 
Чтобы сопоставить переменную символа переменной данных экрана 
следует: 
 

1. Выбрать имя переменной в столбце Subdrawing Data Variable. 
2. В выпадающем меню Mapping Type выбрать тип сопоставления 

Map to Variable. Произойдет открытие окна выбора данных.  
3. Выбрать переменную для сопоставления. Если требуемая 

переменная не отображена в списке Data Source List, можно 
развернуть и отредактировать список. 

4. Нажать OK. Выбранная переменная будет показана в столбце Is 
Mapped To. 
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Переменная символа должна сопоставляться переменной 
экрана того же типа, несмотря на то, что тип источника данных 
может различаться. 

 
Например, переменная с плавающей точкой в файловом источнике 
данных может быть сопоставлена переменной с плавающей точкой в 
источнике данных функции, но не может быть сопоставлена байтовой 
переменной в файловом источнике. Некоторые объекты экрана могут 
быть сопоставлены только определенным типам переменных. 
Например, Tripping Tag (индикатор отключения) должен сопоставляться 
переменной типа Status Color и не может быть сопоставлен переменой 
типа Status State. 
 
При сопоставлении переменой константе правила соответствия типов 
менее строгие. Если переменная символа имеет текстовый тип, то 
сопоставленное константное значение также интерпретируется как 
текстовая строка. Если переменная является числом, в текстовом поле 
для ввода значения константы будет возможно задать только 
численное значение. 
 
Чтобы изменить адрес сопоставления переменной следует: 
 

1. Нажать кнопку с троеточием справа от имени переменной. 
Произойдет открытие окна выбора данных.  

2. Выбрать другую переменную экрана. 
 

При создании экрана с использованием вложенных уровней активных 
символов, необходимо задать открытую область видимости для 
переменных на самом нижнем уровне. На каждом последующем уровне 
переменные также должны сопоставляться открытым (public) 
переменным, если требуется, чтобы они были доступны для 
сопоставления на самом верхнем уровне. 
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Рис. 5.3 4.-2 Изменение сопоставления переменной.    

  
5.4. Объектная динамика 
 
Динамические компоненты могут быть добавлены в графический 
объект таким образом, чтобы изменять представление объекта при 
изменении некоторых данных. 
 
Display Builder предоставляет следующие компоненты, обладающие 
динамическими функциями: 
 
• Динамический атрибут: Изменяет свойства, такие как цвет, тип 

линии, толщина линии, тип кривой и направление дуги. 
• Динамика движения: Изменяет позицию, вращение и масштаб.  
• Символьная динамика: Отображает различные символы в 

зависимости от значения данных. 
• Динамика видимости: Управляет видимостью объекта. 
• Текстовая динамика: Изменяет содержание текстового объекта, 

отображающего значение данных. 
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• Динамика мерцания: Чередует между собой два набора цветов 

объекта для получения эффекта мерцания. Объект может мерцать 
или нет, либо мерцать различными цветами, которые определяются 
значением данных. 

 

  
 
Рис. 5.4.-1 Объектная динамика  
 
Объектная динамика подключается к графическому объекту в виде 
группы. Такая группа называется набором динамических функций. 
Набору динамических функций можно присвоить некоторое имя и 
связать его с множеством графических объектов, задав им, таким 
образом, одинаковый набор динамических характеристик.  
 
Набор динамических функций содержит по одной динамической 
функции каждого типа. Каждая  функция активизируется или нет в 
определенном наборе. К объектам, которые не могут иметь 
динамических характеристик, относятся графы, объекты ввода 
(поскольку они и так динамические по своей сути) и элементы 
управления MFC.  
 
Динамическая функция подключается к переменной данных и 
производит динамические изменения в любом присоединенном объекте 
при изменении этих данных. Например, можно использовать цветовую 
динамику, подключив объект окружности к источнику данных о 
температуре и связав определенные цвета с серией пороговых 
значений температурного диапазона. При возрастании температуры 
окружность будет изменять свой цвет каждый раз, когда был достигнут 
соответствующий порог. 
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Кроме того, пользователь может разработать объектную динамику, 
которая использует различные экраны для отображения прогресса 
выполнения операций и изменения состояний оборудования. Каждый 
символ должен быть экспортирован как файл экрана (.sd). 
 

Изменение набора динамических функций, подключенного к 
нескольким объектам, затрагивает все подключенные 
графические объекты.    

 
Динамика может быть встроена в объект символа путем ее применения 
из файла экрана. Если объект символа содержит встроенную динамику, 
для ее отображения необходимо перейти в режим выполнения экрана. 
Пользователь также может сопоставить внутренние переменные 
данных переменных текущего экрана, см. раздел 5.3.4. 
 
5.4.1. Набор динамических функций 
 
Следующий раздел дает краткое описание использования набора 
динамических функций. 
 
5.4.1.1. Задание имени 
 
Чтобы задать имя набору динамических функций следует: 
 
1. Выбрать объект 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 
3. Нажать кнопку Rename. 
4. Ввести имя в текстовом поле Rename Feature Set 
5. Нажать Enter.  

 

    
 
Рис. 5.4 1.1.-1 Задание имени набора динамических функций .     
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5.4.1.2. Использование именованных наборов 
динамических функций 
 
Задание имени набора динамических функций не является 
обязательным. Тем не менее, выполнение данной операции может 
оказаться достаточно эффективным в случае, когда необходимо 
применить одинаковую конфигурацию динамики для различных 
объектов, которое не являются копиями, или использовать разные 
наборы динамических функций, которые незначительно различаются 
между собой. 
 
Чтобы подключить именованный набор динамических функций к 
объекту следует: 
 
1. Выбрать объект. 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 
3. Открыть раскрывающийся список Fea ure Set Name. t
4. Выбрать именованный набор динамических функций. 

 
Графический объект может быть одновременно подключен только к 
одному набору динамических функций. Чтобы изменить текущее 
подключение  следует выбрать другой именованный набор из 
раскрывающегося списка Feature Set Name. 
 
Рекомендации по совместному использованию 
именованных наборов динамических функций 
 
Совместное использование наборов динамических функций может 
оказаться удобным в случае необходимости задания одинаковых 
динамических характеристик различным типам объектов. 
Неприменимые функции в этом случае игнорируются, не создавая, 
таким образом, проблем при редактировании. Тем не менее, данные 
функции должны быть постепенно удалены пользователем, чтобы 
предотвратить мерцание объектов при их обновлении. Чтобы иметь 
возможность разделять или копировать набор динамических функций, 
он должен быть подключен, по крайней мере, к одному объекту. 
 
Набор динамических функций уничтожается, как только он не 
принадлежит более ни одному объекту. Нельзя использовать 
одинаковое имя для разных наборов динамических объектов в разных 
экранах. При слиянии этих экранов или использовании их в качестве 
символов в одном общем экране, динамические функции могут 
работать некорректно. 
 
5.4.2. Изменение переменной данных, 
используемой динамической функцией 
 
Каждая включенная динамическая функция должна иметь связанные с 
ней данные. По умолчанию, все динамические функции используют 
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default.dat/Var:1. Пользователь может изменить переменную на любую 
другую. Каждая функция связывается только с одной переменной. 
 
Чтобы изменить переменную данных, используемую динамической 
функцией следует: 
 
1. Выбрать объект. 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 

Закладка отображает имена переменных данных для каждой 
динамической функции. 

3. Нажать кнопку … для соответствующей функции. Будет открыто 
диалоговое окно Data Selection.     

4. Выбрать переменную данных. 
5. Нажать OK, чтобы закончить выбор данных. 

 
Имя новой переменной отображается на закладке Dynamic. 
 
5.4.3. Включение и отключение динамических 
функций 
 
Чтобы включить или отключить динамическую функцию следует: 
 
1. Выбрать объект. 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 

Закладка отображает список всех динамических функций. Функции, 
которые не применимы к выбранному объекту, отключены.  

3. Установить (для включения) или снять (для отключения) отметку 
напротив соответствующей динамической функции.  

 
Не все динамические функции применимы ко всем типам графических 
объектов. При включении функций, которые неприменимы к 
выбранному графическому объекту, они не оказывают на него никакого 
воздействия. Тем не менее, при подключении этого же набора функций 
к другому графическому объекту, функции могут быть применены. 
 
5.4.4. Отключение набора динамических функций 
 
Пользователь имеет возможность убрать набор динамических функций 
для выбранного объекта. Выполнение данной операции убирает все 
динамические настройки,  вне зависимости от того именован набор 
функций или нет.  
 
Чтобы убрать набор динамический функций из объекта следует: 
 
1. Выбрать объект 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 
3. Нажать кнопку Remove. 
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5.4.5. Типы динамических функций 
 
Список всех динамических функций отображается на закладке Dynamic 
диалогового окна Object Properties. Динамические функции могут быть 
разделены на группы. Основные группы – это группа динамических 
атрибутов, которые влияют на свойства объекта, и группа динамики 
движения.   
 
Символьная динамика представляет собой особую форму атрибутной 
динамики, которая затрагивает изменение всего рисунка символа в 
целом, а не отдельных его графических атрибутов, таких как тип линии 
или цвет. Динамика видимости и текстовая динамика формируют 
отдельные группы. Краткое описание типов динамических функций 
приведено далее. 
 
5.4.5.1. Динамические атрибуты 
 
Background (цвет фона): 
 
Изменяет цвет фона объекта. Если используется режим заливки Fill 
with Edge, меняется цвет внешней границы объекта. В режиме Edge 
with Fill происходит изменение внутреннего цвета. Атрибут не 
применим к объектам линий, и не оказывает эффекта на объекты типа 
точечный рисунок, иконка, символ, векторный текст, текст типа 
hardware и элементы управления. Динамика изменения цвета фона и 
динамика мерцания являются взаимно исключающими. 
 

Foreground (цвет текста): 
 
Изменяет цвет текста объекта. Если используется режим заливки Fill 
with Edge, меняется цвет внешней границы. В режиме Edge with Fill 
происходит изменение внутреннего цвета. Атрибут не оказывает 
эффекта на объекты типа точечный рисунок, иконка и элементы 
управления. Динамика изменения цвета текста и динамика мерцания 
являются взаимно исключающими. 

 
Blink (мерцание): 
 
Чередует цвет текста и/или фона между двумя наборами цветов для 
создания эффекта мерцания. Объект может мерцать или не мерцать, а 
также мерцать различными цветами в зависимости от значения 
данных. Динамика мерцания и динамика изменения цвета текста или 
фона являются взаимно исключающими. Динамика мерцания не 
оказывает эффекта на объекты типа точечный рисунок. 
 

Line Type (тип линии): 
 
Изменяет тип линии контура объекта. Атрибут применим к линиям, 
дугам, окружностям, эллипсам, многоугольникам и сплайновым 
объектам. 
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Line Width (ширина линии): 
 
Изменяет толщину линии контура объекта. Атрибут применим к 
линиям, дугам, окружностям, эллипсам, многоугольникам и 
сплайновым объектам. 

    
Arc Direction (направление дуги): 
 
 Изменяет направление дуги. Атрибут применим только к дугам. 
 
Curve Type (тип кривой): 
 
Изменяет тип кривой многоугольника, ломаной линий, открытого и 
закрытого сплайна. Атрибут применим только к указанным типам 
объектов. 
 

5.4.5.2. Символьная динамика 
   
Изменяет экран символа в режиме выполнения. Применима к символам 
с отключенной динамикой. 
 
Существует два метода, позволяющих реализовать изменение объекта 
символа: 
 
• Создание серии экранов и использование символьной динамики для 

изменения экрана при показе. 
• Создание одного экрана с внутренней динамикой и использование 

экрана в качестве символа с включенной динамикой. 
 

Следует различать динамику, применяемую к символу, такую как 
символьная динамика или динамика движения, и динамику, 
включенную в сам символ. 
 
5.4.5.3. Динамика видимости 
 
Visibility (видимость): 
 
Изменяет режим видимости объекта в зависимости от значений 
данных и пороговой настройки. Атрибут видимости применим к 
любым типам объектов. По умолчанию все объекты видимы в Display 
Builder. Атрибут может использоваться для отображения и скрытия 
различных сообщений и тревог. Видимость объекта управляется 
только через объектную динамику. Следует отметить, при 
использовании метода перерисовки Redraw Immediate Erase Method 
динамика видимости не работает во вложенных экранах. 
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5.4.5.4. Текстовая динамика 
 
Text (текст): 
 
Изменяет содержание текстового объекта для отображения значения 
данных в заданном формате. Применим ко всем типам текстовых 
объектов. Атрибут позволяет управлять представлением и 
выравниванием текста, а также комбинировать статические и 
динамические компоненты в одном объекте. Использование 
текстовой динамики предоставляет большую гибкость, чем 
использование текстовых графов (Text Graph) или цифровых графов 
(Digits Graph). 
 

5.4.5.5. Динамика движения 
 
Fill (заливка):  
 
Опция заливки применима к окружностям, дугам, эллипсам, 
прямоугольникам, многоугольникам, ломаным линиям, а также 
сплайнам и оказывает эффект только в случае использования методов 
заливки Fill, Edge with Fill или Fill with Edge, которые являются взаимно 
исключающими. Значения из диапазона отображаются на значения 
вне диапазона и выражаются в процентах от площади объекта с 
отношением 1=100%. Значения, находящиеся вне диапазона, должны 
всегда быть от 0 до 1, значения большие 1 не имеют смысла, см. 
раздел 5.4.6. 
 

Fill Left: Изменяет область заливки объекта, заливка 
производится справа налево. Процентное отношение 
измеряется от 0 на правой границе до 1 на левой. 
 
Fill Right: Изменяет область заливки объекта, заливка 
производится слева направо. Процентное отношение 
измеряется от 0 на левой границе до 1 на правой. 
 
Fill Up: Изменяет область заливки объекта, заливка 
производится снизу вверх. Процентное отношение измеряется 
от 0 на нижней границе до 1 на верхней. 
 
Fill Down: Изменяет область заливки объекта, заливка 
производится сверху вниз. Процентное отношение измеряется 
от 0 на верхней границе до 1 на нижней. 
 

Rotate (вращение): 
 
Вращает объект относительно преобразуемой якорной точки. Не 
используется для объектов, которые имеют одну или две контрольные 
точки. Трансформируемая якорная точка выбирается при помощи 
раскрывающегося меню Transform Anchor. 
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Scale (масштаб): 
 
Изменяет масштаб объекта, используя трансформируемую якорную 
точку в качестве относительной. Не используется для текстовых 
объектов типа hardware. Трансформируемая якорная точка 
выбирается при помощи раскрывающегося меню Transform Anchor. 
Значения вне диапазона отображаются в процентах, где 1=100%. 
Например, диапазон [0,1] делает объект эквивалентным или меньшим 
его исходного размера. Отрицательные значения приводят к 
вертикальному или горизонтальному зеркальному отражению рисунка. 
 

Scale X (масштаб по оси X): 
 
Изменяет масштаб объекта, используя трансформируемую якорную 
точку в качестве относительной. Не используется для текстовых 
объектов типа hardware. Значения вне диапазона отображаются в 
процентах, где 1=100%. Отрицательные значения приводят к 
горизонтальному зеркальному отражению рисунка справа налево. 

 
Scale Y (масштаб по оси Y): 
 
Изменяет масштаб объекта, используя трансформируемую якорную 
точку в качестве относительной. Не используется для текстовых 
объектов типа hardware. Значения вне диапазона отображаются в 
процентах, где 1=100%. Отрицательные значения приводят к 
вертикальному зеркальному отражению рисунка сверху вниз. 

 
Absolute Move X (абсолютное перемещение по X):  

   
Перемещает трансформируемую якорную точку объекта относительно 
начала области рисования в горизонтальном направлении. Применима 
ко всем типам объектов. Значения вне диапазона отображаются в 
координатах world.   

 
Absolute Move Y (абсолютное перемещение по Y):  

   
Перемещает трансформируемую якорную точку объекта относительно 
начала области рисования в вертикальном направлении. Применима 
ко всем типам объектов. Значения вне диапазона отображаются в 
координатах world.   

 
Relative Move X (относительное перемещение по X):  

   
Перемещает трансформируемую якорную точку объекта относительно 
исходной позиции в горизонтальном направлении. Применима ко всем 
типам объектов. Значения вне диапазона отображаются в 
координатах world.   
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Relative Move Y (относительное перемещение по Y):  

   
Перемещает трансформируемую якорную точку объекта относительно 
исходной позиции в вертикальном направлении. Применима ко всем 
типам объектов. Значения вне диапазона отображаются в 
координатах world.   

 
Path Move (путь перемещения): 
 
Перемещает трансформируемую якорную точку объекта вдоль 
границы многоугольника. Применима ко всем типам объектов. 
Значения вне диапазона отображаются в единицах, отображенных на 
границу многоугольника.   

 
Замечания по использованию 
 
Объекты типа многоугольник также могут обладать динамикой. Это 
позволяет создавать сложное перемещение для объектов с 
использованием функции Path Move, например, вращать 
многоугольники. Многоугольник может использовать динамику Path 
Move, но не может использовать самого себя в качестве траектории. 
 
Следует обратить внимание, что траектория перемещения по 
многоугольнику может использовать объект многоугольника только 
типа Polygon, но не Closed, Open или Floating. Если в качестве 
траектории используются различные типы графических объектов, 
динамические объекты могут перемещаться не так, как ожидалось. Это 
объясняется тем, что динамические объекты перемещаются от одной 
контрольной точки к другой и не обязательно следуют вдоль периметра 
других объектов. 
 
Кроме того, следует отметить, что после того как графическому объекту 
была задана динамика перемещения вдоль границы объекта 
многоугольника, она будет сохранена в свойствах графического 
объекта даже после удаления объекта траектории. Чтобы корректно 
отключить динамическое поведение, следует сначала отключить 
динамическую функцию графического объекта и лишь затем удалить 
объект многоугольника, задающий траекторию перемещения. 
 
5.4.6. Задание диапазона данных 
 
Диапазон данных отображается на закладке Dynamic диалогового окна 
Object Properties. 
 
5.4.6.1. Входной диапазон данных 
 
Поля In Min и In Max определяют соответственно минимальное и 
максимальное входное значение, получаемое от переменной данных. 
Если значение переменной превышает максимальное, Display Builder 
отображает максимальное установленное значение. Аналогично, если 
входное значение меньше минимального, будет отображено 
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минимальное заданное значение. Входной диапазон может определять 
некоторый фактический диапазон данных или же использоваться в 
качестве фильтра. 
 
Чтобы установить входной диапазон данных следует: 
 
1. Выбрать объект. 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 

Закладка отображает имена переменных данных для каждой 
динамической функции. 

3. Ввести новые значения в полях In Min и/или In Max. Нижний предел 
должен быть меньше верхнего. 

 
Входной диапазон неприменим к текстовым объектам. По умолчанию 
используется диапазон от 0.0 до 1.0. 
 
5.4.6.2. Выходной диапазон данных 
 
Поля OutMin и OutMax определяют соответственно минимальное и 
максимальное отображаемое значение. Входной диапазон данных 
отображается на выходной. Например, для динамической функции 
Rotate входной диапазон [0,1] может быть отображен на выходной 
диапазон [0,360] в градусах. 
 
Чтобы установить выходной диапазон данных следует: 
 
1. Выбрать объект. 
2. Перейти на закладку Dynamic диалогового окна Object Properties. 

Закладка отображает имена переменных данных для каждой 
динамической функции. 

3. Ввести новые значения или нажать кнопку … для открытия 
диалогового окна Data Selection. 

 
Для выходного диапазона, заданного двумя величинами, нижний 
предел может быть больше, чем верхний. Например, свопинг значений 
верхнего и нижнего предела для опции Move Path приводит к тому, что 
объект будет перемещаться вдоль траектории в обратном направлении. 
 
5.5. Использование правил 
 
Правила позволяют при помощи Display Builder производить 
трансформацию коллекций индивидуальных экранов в функциональный 
интерфейс приложения. Правила дают интерфейсу возможность 
выполнять множество различных действий в качестве ответа на 
события, инициируемые пользователем, например команды мыши, или 
на события, происходящие в приложении, например загрузка экрана. 
 
При помощи правил интерфейс приложения может реализовывать 
такие действия как переключение между экранами, добавление 
объектов из других экранов в текущий, манипулирование значениями 
данных и изменение коэффициента обновления. Пользователь имеет 
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возможность выполнить обратную запись данных в источник данных, 
который поддерживает запись. Кроме того, существует возможность 
активировать специфические действия посредством опции Execute 
Function in Script.  
 
Например, командная кнопка (execute button, см. раздел 3.2.) имеет 
внутренне правило, которое выполняет VBA-script при нажатии символа 
кнопки. 
 

Для включения внутреннего правила, выполняющего функцию 
сценария, для символа и экрана процесса, содержащего 
данный символ, должен использоваться один и тот же файл 

сценария. Рекомендуется всегда использовать файл сценария по 
умолчанию \sc\prog\graphicsEngine\etc\SYS600_scripts.bas.      
  

 
 
 Рис. 5 5.-1 Добавление нового правила.    
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